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Dana User’s Guide 11

About This Guide
Welcome to the Dana™ by AlphaSmart®. This guide is designed to help 
you get up and running quickly on your electronic notebook. It describes 
all you need to know about how to use Dana and the applications that 
come with it. 

This guide shows you how to:

• Identify all the parts of Dana 

• View and enter data 

• Use Dana with your computer

• Personalize your Dana with your own preference settings

After you become familiar with the basic functionality of Dana, you can 
use the rest of this guide as a reference for less common tasks, for 
maintaining your electronic notebook, and also as a source of information 
if you have problems operating it.
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1
Introduction to Dana
Dana™ by AlphaSmart® is the versatile laptop alternative for students, 
researchers and professionals on the go. It combines the convenience and 
affordability of a Palm-Powered™ device with the ergonomics of a 
lightweight laptop. Dana is easy to use, rugged and has exceptional battery 
life to keep you computing while away from your PC. 

You’ll find it easy to start using the Dana electronic notebook, become 
familiar with its keyboard, and use HotSync® technology to synchronize 
(exchange and update) Dana and Palm ™ Desktop software. Once you 
familiarize yourself with the basic workings of Dana, you’ll easily be able 
to do the following:

• Compose documents in AlphaWord, a full-featured word processor

• Enter all schedule details in the Date Book and view them by the 
day, week, or month, and even set an alarm to remind you of an 
important event

• Keep all contact names, addresses, phone numbers, and other 
details in the Address Book, so you can find them as soon as you 
need them

• Add tasks to the To Do List, prioritize them so you don’t overlook 
them, and assign them a due date

• Ensure that you don’t lose any of this important information simply 
by synchronizing data with Palm Desktop software on the 
computer to create a backup copy

• Customize your electronic notebook and set different levels of 
security to prevent unauthorized users from viewing your data

NOTE: Documentation Note: In this document keyboard keys will be 
shown in bold. Also any “two-key” key commands (i.e. function-calc) 
are executed by pressing the indicated keys simultaneously
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System requirements for Windows
To install and operate Palm Desktop software on Windows, the computer 
system must meet the following requirements:

• PC running Windows 98/2000/Me/XP

• 8 MB RAM (memory) minimum, 16 MB recommended (required 
with Windows NT 4.0)

• 30 MB available hard disk space

• VGA monitor or better

• Internet Explorer 4.01 service pack 2 or higher

• CD-ROM drive

• Mouse pointing device

• One available USB port

System requirements for Mac OS
To install and operate Palm Desktop software on the Mac OS, the computer 
system must meet the following requirements:

• Power PC processor running Macintosh OS 9 or higher

• 5 MB RAM (memory) minimum

• 15 MB available hard disk space

• CD-ROM drive

• Mouse pointing device

• One available USB port
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Dana components - front panel controls
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file keys (F1-F8). In AlphaWord, accesses the 8 workspaces (F1-F8). See 
"App Shortcuts" on page 168 for details on reassigning these keys to launch 
other applications when not in AlphaWord.

on/off key. Pressing the on/off key turns Dana on (if it is off) and returns 
to the last screen that was displayed. Press the on/off key to turn Dana off.

Use the backlight to illuminate the screen in low-light conditions. When 
Dana is on, hold down the on/off key for about two seconds to turn the 
backlight on and off. 

function key. Press in conjunction with other keys to access the key’s 
secondary function (indicated by the yellow text). For example pressing 
function-contrast displays the onscreen contrast control. You can adjust 
the screen for the clearest screen display according to current lighting 
conditions. For more information see "Adjusting the contrast of your 
screen" on page 21.

cmd/shortcut key. Press in conjunction with a letter key to execute a 
menu command. For example cmd-c will execute the Edit Copy menu 
command. To find the shortcut key for a specific menu command, press the 
menu key to drop down the menu. The shortcut key is to the right of the 
menu command after the .

stylus. The tool to use for tapping on Dana’s touch-sensitive screen. It can 
be used for manipulating all on-screen controls including: tapping icons, 
buttons, and menu items, dragging the scroll bar and more. To use the 
stylus, remove it from the channel and hold it as you would a pen or pencil

application keys. Activates the individual Dana applications that 
correspond to the names on the keys: date for Date Book, address for 
Address Book, to do for To Do List, and memo for AlphaWord. "Keys 
preferences" on page 160 for details on reassigning these keys to other 
applications on your electronic notebook.

utility keys. Activates the commands or utilities that correspond to the 
names on the keys: find for the find utility, menu to drop down the menu 
in an application, apps for the Application Launcher, and send for sending 
text from AlphaWord or beaming.

You can also set it up so that pressing one of the application or utility keys 
turns on Dana and opens the corresponding application or utility. See 
"Power On Keys" on page 169 for details.
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Locating back panel components

IrDA port. Uses infrared technology to transmit and receive data to and 
from other Danas or infrared-enabled Palm OS handhelds. See "Beaming 
Information" on page 175 for more information. Also allows printing to 
infrared-enabled printers. See "Printing Setup" on page 72 for more 
information.

AC Adapter port. Connects Dana to the wall current through the AC 
adapter. This allows you to charge Dana rechargeable batteries.

Expansion card slots.Dana has 2 card slots that accepts Secure Digital (SD) 
or MultiMedia Card (MMC) expansion cards. These enable you to add 
additional software applications, memory, or hardware. You can also use 
an expansion card to back up data when it is inconvenient to perform a 
HotSync operation.

USB printer. Connects Dana directly to a printer via a USB cable so you 
can print AlphaWord or other printable files. When Dana is connected to 
the AC Adapter or computer, the USB Printer port can also be used to 
power devices with USB.

USB computer. Connects Dana to your computer via a USB cable so you 
can send files from AlphaWord, as well as update the information between 
Dana and your computer using HotSync technology.

Charging Dana 
Dana comes with a rechargeable battery that recharges whenever it is 
connected to its AC Adapter or to the computer via a USB cable (charging 
will only occur while the computer is on). You can also use standard AA 
alkaline batteries (not included).
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You will need to connect Dana to the AC adapter for four hours or the 
computer for eight hours to get a full charge. Use the AC adapter that 
comes with Dana, or one that meets the following specification: Input: AC 
120v 60Hz 9W Output: DC 7.5V 500 mA. A fully charged Dana should run 
for over 25 hours. 

Using Palm applications
Dana utilizes all the power and efficiency of the Palm operating system, 
and expands its capabilities with a larger screen, the inclusion of the 
AlphaWord word-processing application and many other features. 

AlphaWord functions at the full Dana screen resolution of 560x160 pixels, 
and most of the standard Palm applications like Address Book, To Do List, 
Memo Pad and Date Book have also been updated to take advantage of the 
larger screen. 

However, other Palm programs might not have been revised to run on 
Dana's larger screen. These Palm program features and actions won't be 
restricted in any way, but the program will be centered in the middle of the 
Dana screen.

Upgrade information
If you already own a Palm OS handheld, you must install the version of 
Palm Desktop software that comes with Dana in order for Dana to 
communicate with Palm Desktop Software. Also, perform a HotSync® 
operation using your old handheld and cradle/cable before you install the 
new Palm Desktop software. This ensures that all data on your handheld is 
on your desktop computer, and is available for easy transfer to Dana. If 
you use another personal information manager (PIM), such as Microsoft 
Outlook, you still must install the most recent HotSync Manager and 
conduit software for the PIM. For information on conduit software, go to 
www.alphasmart.com.

If you want to continue using your old Palm OS handheld as well as Dana, 
you will need to choose a new user name for Dana during Palm Desktop 
software install on a PC or during the first HotSync on a Macintosh. You 
will also need to export any data from Palm Desktop software that you 
want to transfer to Dana. Later you can import this data into your new 
Dana user name.
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Exporting/Importing Data from Palm Desktop 
Software
Complete the following steps if want to continue using your old Palm OS 
handheld as well as Dana

1. Synchronize your old Palm OS handheld with your old Palm Desktop 
software to ensure that the latest information from your Palm OS 
handheld is on your desktop computer

2. Launch the Palm Desktop Software you use with your old handheld.

3. Go to an application you want to export data from (i.e.Date Book).

4. Select Export under the File menu.

5. Type in a file name and click the Export button.

6. Repeat steps 2-4 for the other applications (i.e. Address Book, To Do List, 
and Memo Pad).

7. Once you have completed "Installing Palm Desktop software" on page 
31, launch the new version of Palm Desktop software. Select Import 
under the File menu to import the files that you exported in step 4.

Upgrading your Palm Desktop software
Complete the following steps if you only want to use Dana (you no longer 
want use your old Palm OS handheld). To upgrade your old Palm OS 
handheld, follow the steps below:

1. Synchronize your old Palm OS handheld with your old Palm Desktop 
software to ensure that the latest information from your Palm OS 
handheld is on your desktop computer.

2. To prevent potential data loss, go to the folder that stores Palm Desktop 
software, copy the folder and its contents, rename it (for example, Palm 
Backup), and store the copy outside the Palm Desktop software folder.

3. Follow the installation instructions in "Installing Palm Desktop 
software" on page 31. Make sure you install the new software in the 
same folder as the old software.

4. To prepare for the first HotSync operation that will synchronize Dana 
with your new Palm Desktop software, go to the HotSync Manager and 
choose Custom.
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NOTE: Select your username, if it does not already appear in the box.

5. For all conduits, tap Change, and select the Desktop overwrites 
handheld option. Then click Done. See "Customizing HotSync 
application settings" on page 183 for more information.

6. Connect Dana to your computer using a USB cable, and press function-
sync (press the function and sync keys simultaneously). If the Select 
User dialog box appears, select your username.

NOTE: If you customized the modem setup on your old Palm OS 
handheld, you must re-enter the modem initialization string. Any 
passwords you select on your old Palm OS handheld are not restored 
during this HotSync operation. Records you previously marked Private 
remain marked Private, but you need to reenter a password on your new 
electronic notebook.

Maintaining a unique name for each Palm OS 
device
To prevent unexpected results during HotSync operations and possible 
data loss, Danas (or other Palm OS devices) that HotSync to the same 
computer should not have the same user name. If you plan to continue 
using you old handheld as well as Dana, make sure you create a new user 
name for Dana.

Tapping versus clicking 
Just as you use a mouse pointer to click elements on your computer ’s 
screen, you use the stylus to tap elements on your electronic notebook’s 
touch-sensitive screen. Tapping is one of the basic actions used to execute 
tasks on your electronic notebook.
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IMPORTANT: Always use the point of the stylus for tapping or making 
strokes on the Dana screen. Do not use a pen, pencil, or any other sharp 
object to write on the screen. If you misplace your stylus, visit the 
www.alphasmart.com site for information on a replacement.

With your electronic notebook turned on, you can tap the screen to 
perform many operations, such as the following:

• Open applications.

• Choose menu commands.

• Initiate a global Find operation.

• Select options in dialog boxes.

• Open the onscreen keyboards.

Just as you drag the mouse to select text or move objects on your computer, 
you can drag the stylus to select text. In addition, you can use the stylus to 
drag the slider of any scroll bar.

Starting Dana and calibrating its screen
The first time you start Dana, setup instructions appear onscreen. These 
instructions include a calibration screen, or digitizer. Calibration aligns the 
internal circuitry of Dana with its touch-sensitive screen, so Dana can 
detect the task you want to perform when you tap an element on the 
screen.

To calibrate your screen:

1. Press the apps key repeatedly till you see ALL in the top right corner of 
the Applications Launcher, and then tap Prefs.

2. In the pick list in the upper right corner of the screen, tap Digitizer.

3. Follow the on-screen instructions, tapping the screen where indicated.

Adjusting the contrast of your screen 
You can adjust the contrast of your screen to make it easy to see in a variety 
of lighting conditions. 
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To adjust the contrast of your electronic notebook screen:

1. Turn on your device. 

2. Press function-contrast. The Adjust Contrast slider appears.

3. Do one of the following: 

• Drag the slider to adjust the contrast.

• Tap to the right or left of the slider to adjust the contrast in small 
increments.

• Press or press and hold the function-PageUp and function-
PageDown keys to adjust the contrast in small or large increments, 
respectively. 

Opening applications
You can use the Applications Launcher to open any application installed 
on your electronic notebook. You can also open the four main 
applications—Date Book, Address Book, To Do List, and AlphaWord—
with the application keys located on the right side of the top row of keys.

TIP: When you press an application key, the selected application 
immediately opens. 

In addition to providing a way for you to open applications, the 
Applications Launcher displays the current time, battery level, and 
application category. 

To open an application:

1. Press the apps key or tap the Applications Launcher icon. 
Applications Launcher
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2. Tap the icon of the application you want to open. If you have many 
applications installed on your electronic notebook, tap the scroll bar to 
see all the available applications.

TIP: You can find an application quickly by typing the first letter of its 
name. The Applications Launcher scrolls to the first application with a 
name that begins with that letter.

Using the Dana interface

Your electronic notebook includes the following interface elements:

• A 1 in the lower right corner of the WritePad that displays the 
numeric keyboard when tapped; note that the cursor must be in an 
input field for this option to work. 

• An A in the lower left corner of the WritePad that activates the 
alphabetic keyboard when tapped; note that the cursor must be in 
an input field for this option to work.

Pick list

Text entry area Opens alphabetic keyboard Opens numeric keyboard

Icons
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• Icons to open applications , menus , Calculator , and

find text anywhere in your data .

• Pick lists that display a list of choices. Tap the black triangle next to 
the pick list name to display a list of choices, and then tap an item in 
the list to select it.

• Text areas and screens in which you can enter information.

• Command buttons that initiate a command when tapped. 
Command buttons appear in dialog boxes and at the bottom of 
application screens.

• Check boxes that indicate the state of a corresponding option. A 
check mark in a check box indicates that the option is active. If a 
check box is empty, tapping it inserts a check mark. If a check box is 
checked, tapping it removes the check mark.

• A scroll bar to move through long notes or memos. Tap and hold 
down the scroll bar slider to scroll through pages; tap the slider 
arrow at either end to move one line at a time. To scroll to the 
previous page, tap the scroll bar just above the slider; to scroll to the 
next page, tap the scroll bar just below the slider. You can also scroll 
to the previous and next pages by pressing the upper and lower 
portions of the scroll button on the front panel of the electronic 
notebook.

• Next/previous arrows that display the previous and next page of 
information.

Previous/next arrows

Command button Scroll bar

Check 
box
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Using menus and menu commands 
Menus on Dana are easy to use, and work the same way in all applications. 
Menu bars and manual commands differ based on the application and the 
area of the application in which you’re working. For example, in the Memo 
Pad, the Memo List screen and the Memo screen display different menus. 
Not all applications have a menu bar.

Menu commands for each application are described in the corresponding 
application’s chapter, with the exception of the Edit menu. For information 
on Edit menu commands, see "Using the Edit menu" on page 128.

Most menu commands have an equivalent keyboard shortcut or Graffiti 
command stroke. To use Graffiti menu commands, menus must be closed. 

To display a menu bar and choose a command: 

1. Do one of the following: 

• Open an application (such as the To Do List); tap the Menu icon  
or press the menu key. Select the desired command from the menu. 

• Tap the inverted tab at the top of any application’s screen (The 
Calculator does not have an inverted tab); then tap the desired 
command. 

• Press cmd-tab or in the Graffiti text area of the WritePad, drag a 
diagonal line from the lower left to upper right to display the 
Command toolbar. The command bar is displayed for 
approximately 4 seconds.

Menu bar
Keyboard shortcut
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Tap an icon that represents the command you want, or enter the shortcut 
for the command in the Graffiti text area below the Command toolbar. For 
example, to choose Select All in the Edit menu, draw the Graffiti command 
stroke in the text area to display the Command toolbar; then draw the 
letter S. Note that if you wait more than three seconds to draw the shortcut 
letter, you’ll have to redraw the Graffiti command stroke to redisplay the 
Command toolbar.

TIP: If you know the keyboard shortcut for a menu command, just 
press it at the same time as the cmd key to execute the command.

Displaying tips
Many of the dialog boxes that appear on your electronic notebook contain 
a Tips icon in the upper right corner. Tips anticipate questions you may 
have and provide shortcuts for using the dialog box or other useful 
information. 

To display a tip:

1. Tap the Tips icon (the lowercase I in the upper right corner of the dialog 
box). 

2. Tap Done after reading the tip. 

Entering data
You can enter data into your Dana in four ways:

• Using the keyboard

• Using the onscreen keyboard

Tip icon
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• Using Graffiti

• Entering or importing data in Palm Desktop software, and then 
synchronizing with your electronic notebook

For more information, see these topics in "Entering Data" on page 37.

Customizing Dana
You can customize Dana by using the Preferences application. You can 
enter personal information such as your name and address; change the 
time, date, and time zone; view different date and time formats when you 
travel; turn off sounds; and configure your Dana to work with a modem or 
network. See "Setting Preferences" on page 159 for details.

Selecting the Preferences screen
You set preferences to customize your device. To select the Preferences 
screen, do the following:

1. Press the apps key.

2. Select All or System from the pick list in the upper right corner of the 
screen.

3. Tap Prefs.

Personalizing your electronic notebook
Owner preferences let you record a name, company name, phone number, 
or any other information you want to include on your electronic notebook.

If you use the Security application to turn off and lock your electronic 
notebook with a password, information that you enter in the Owner 
Preferences appears the next time you turn on Dana. 

Setting owner preferences

1. From the Preferences screen, tap Owner from the pick list in the upper 
right corner.

2. On the Owner Preferences screen, enter the text you want to associate 
with your electronic notebook. If you enter more text than can fit on one 
screen, a scroll bar appears at the right side of the screen. 
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NOTE: If you have assigned a password to your device using the 
Security application, you must unlock the Owner Preferences screen to 
change the information on it. 

To unlock the Owner Preferences screen: 

1. Display the Owner Preferences screen.

2. Tap Unlock. The Unlock Message dialog box appears. 

3. Enter your current password (the one you entered in the Security 
application); then tap OK. 

4. Edit the Owner Preferences text as desired. 

Setting the date, time, and time zone
The General Preferences screen lets you set the date, time, and time zone 
for your device.

To set the date:

1. Press the apps key repeatedly till you see ALL in the top right corner of 
the Applications Launcher, then tap the Prefs icon.

2. From the pick list in the upper right corner, tap Date & Time.

3. On the Date & Time screen, tap the Set Date box; then tap the arrows at 
the top of the Set Date Screen to select the current year.

4. Tap the month; then tap the current date.
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The screen closes and the dates you selected are displayed in the Set Date 
box.

To set the time:

1. Press the apps key repeatedly till you see ALL in the top right corner of 
the Applications Launcher; then tap the Prefs icon.

2. From the pick list in the upper right corner, tap Date & Time.

3. On the Date & Time screen, tap the Set Time box; then tap the Up or 
Down arrow to change the hour. 

4. Tap each minute number, and then tap an arrow to change the number. 

5. If available, tap AM or PM. 

6. Tap OK to set the new time and return to the Date & Time screen.

NOTE: To display time based on a 24-hour clock, change the time 
format. See "Time, date, week start, and numbers formats" on page 163

To set the time zone:

1. Press the apps key repeatedly till you see ALL in the top right corner of 
the Applications Launcher; then tap the Prefs icon.

2. From the pick list in the upper right corner, tap Date & Time.

3. On the Preferences screen, tap the Set Time Zone box.

4. Use the up and down arrows to scroll to your country and time zone.

5. Make sure your time zone is highlighted, then tap OK.
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TIP: Choose the time zone from the list that corresponds to where you 
are. When you travel, use this dialog to change time zones. If you’re not 
sure what time zone you are in, find out what time it is, and select the 
time zone which shows the current new time. Do not use the time zone 
dialog to switch between daylight savings time and standard time. Use 
the Daylight Savings pick list.

The screen closes and the dates you selected are displayed in the Date & 
Time screen.

To set daylight savings time:

1. Press the apps key repeatedly till you see ALL in the top right corner of 
the Applications Launcher, then tap the Prefs icon.

2. Select Date & Time from the pick list in the upper right corner of the 
screen

3. Tap on the Daylight Saving pick list to toggle this feature on or off.

Palm Desktop software
Palm Desktop software includes many of the same main applications as 
Dana: Address Book, Date Book, To Do List, Memo Pad. You can use the 
HotSync feature of this software to back up and exchange data between 
your electronic notebook and computer.

It’s a good idea to back up your data in case something happens to the data 
on your electronic notebook. Changes you make on Dana or the Palm 
Desktop software appear in both places after you synchronize.

With Palm Desktop software, you can do the following:

• Work with the Dana applications on your computer. Palm Desktop 
software duplicates the Date Book, Address Book, To Do List, and 
Memo Pad applications on your electronic notebook, so that you 
can view, enter, and modify any data stored on your electronic 
notebook.

• Back up the data stored on Dana with HotSync technology and 
synchronize the data on your Palm Desktop software. 
Synchronization is a one-step procedure that ensures your data is 
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always safe and up-to-date. See "Exchanging and Updating Data 
using HotSync® Operations" on page 179 for more information. 

• Import and export data, so you can easily transfer data from other 
desktop applications into any of your main applications. See 
"Importing data" on page 51 for more information.

• Print your Date Book, Address Book, To Do List, and Memo Pad 
information on any printer connected to your computer.

Installing Palm Desktop software
The following instructions guide you through installing Palm Desktop 
software so that you can transfer data from your computer to your 
electronic notebook.

After installation, refer to the online Help in Palm Desktop software for 
information on how to use the software.

To ensure a safe and uninterrupted installation of Palm Desktop software, 
do the following before installing:

• Turn off your computer and connect the USB cable to it. Do not 
connect your electronic notebook to the USB cable until instructed.

• Do not copy the Palm Desktop software files to your computer’s 
hard disk. You must use the installer to place the files in their 
proper locations and to decompress the files. 

To install Palm Desktop software on a PC:

1. Insert the Palm Desktop for Dana software CD-ROM into the 
computer’s CD-ROM drive.

2. When the window showing the CD's contents opens, double-click on 
setup.exe.

NOTE: If a window showing the CD's contents does not appear, click 
the Windows Start button, choose Run, enter D:\setup.exe, and then 
click OK. If necessary, replace D: with the drive letter assigned to your 
CD-ROM drive.

3. When the Palm Desktop software Installer Menu screen appears, click 
the Install button to begin the installation procedure.
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4. Follow the onscreen instructions to complete the installation. If 
prompted, connect your electronic notebook to the USB cable.

IMPORTANT: If already own a Palm OS handheld and want to 
continue using it, you should create a new user name to use with Dana.

To install Palm Desktop software on a Macintosh:

IMPORTANT: Palm Desktop Software for the Macintosh requires OS 9 
or higher.

1. Insert the Palm Desktop for Dana software CD-ROM into the CD-ROM 
drive.

2. Double-click the Palm Desktop CD icon.

3. Double-click the Palm Desktop Installer icon.

4. Follow the onscreen instructions to complete the installation.

Installing AlphaBeam
Dana lets you send plain text (no formatting) from AlphaWord to any 
application on a computer that accepts text. If you want to send text via a 
wireless (IrDA) connection, you must first install AlphaBeam on your 
computer. AlphaBeam transfers the contents of the AlphaWord file into the 
Clipboard and issues a Paste command. If your application is the top 
window (in the foreground), the contents of the file will be pasted into it. If 
the top window is not capable of accepting the pasted text, the text is saved 
on the clipboard. Bring the document to the foreground, and perform a 
Paste function to retrieve the text from the clipboard.

To install AlphaBeam on a PC:

The PC must be equipped with a built-in IrDA-standard transceiver or a 
wireless pod. The PC must be running Windows 95, Windows 98, 
Windows Me, Windows 2000 or Windows NT. 
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WARNING! If you are using a USB IR Wireless Pod, you must 
complete the AlphaBeam Setup before connecting the USB IR Wireless 
Pod to your PC.

Installation Instructions: USB IR pod

1. Double-click the Setup.exe file in the AlphaBeam Installer folder under 
the AlphaWord folder inside the Palm folder on your computer.

2. Once you have completed the setup process, connect the USB IR pod to 
an available USB port on your computer

3. Launch AlphaBeam from the AlphaSmart program group.

Installation Instructions: Serial IR pod

1. Plug the AlphaSmart PC IR Wireless Pod into a COM port on the PC. A 
COM port is either a 9 pin or 25 pin male DB connector. Be sure and note 
which COM port the IR Pod is plugged into. (i.e. COM1, COM2 etc.)

2. Double-click the Setup.exe file in the AlphaBeam Installer folder under 
the AlphaWord folder inside the Palm folder on your computer.

a. Installing Infrared Support on Windows 98: During the setup you 
will be asked which COM port the PC IR Wireless Pod is connected 
to. You will also be asked to set up a simulated COM port. When the 
program suggests a simulated COM port, just press the Next button.
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b. Installing Infrared Support on Windows 2000 - If you would like to 
use other IR devices in addition to Dana, you will need to do the 
following after finishing Setup:

1. On the Start menu, select Control Panel from the Settings list.

2. Double-click on the “Add/Remove Hardware” icon.

3. Click “Next” for each screen in the wizard until you see a list of 
Devices in the “Choose a Hardware Device” window.

4. Double-click “Add a new device”, then select the option “No, I want 
to select the hardware from a list” and click “Next”.

5. Select “Infrared devices” from the list of Hardware Types.

6. Select “ACTiSYS” from the list of Manufacturers and select the 
“ACTiSYS IR-220L Serial Infrared Device”.

7. Click “Next” to accept the default settings and install the software.

8. Select the appropriate Serial (COM) port to which the IR pod is 
connected and then finish up the installation. 

3. Launch AlphaBeam from the AlphaSmart program group.

To install AlphaBeam on a Macintosh:

The Macintosh must be equipped with a Mac Serial IR Wireless Pod 
(purchased from AlphaSmart, Inc.) or a USB IR Wireless Pod (purchased 
from AlphaSmart, Inc.)

Installation Instructions: USB IR Wireless Pod

1. Insert the Palm Desktop for Dana software CD-ROM into the CD-ROM 
drive and double-click AlphaBeamInstaller located in the Extras folder, 
or double-click AlphaBeamInstaller under the AlphaWord folder inside 
the Palm folder on your computer.

2. Plug the pod into the USB port of the Macintosh.

3. Select Preferences menu item from Edit menu.

4. In the Preferences dialog click on the Receive checkbox.

5. In the Preferences dialog select USB IR Wireless pod in the popup menu.

6. Press the OK button.
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Installation Instructions: Mac Serial IR Wireless Pod

1. Insert the Palm Desktop for Dana software CD-ROM into the CD-ROM 
drive and double-click AlphaBeamInstaller located in the Extras folder, 
or double-click AlphaBeamInstaller located in the AlphaWord folder 
inside the Palm folder on your computer.

2. Plug the pod into either the Modem or Printer port of the Macintosh.

3. Be sure and note which serial port the pod is plugged into.

4. Select Preferences menu item from Edit menu.

5. In the Preferences dialog click on the Transfer checkbox.

6. In the Preferences dialog select Modem or Printer in the popup menu.

7. Press the OK button.

Connecting Dana to your computer
The USB cable that comes with Dana enables you to synchronize the 
information on your electronic notebook with the Palm Desktop software 
using HotSync technology.

IMPORTANT: The version of Palm Desktop Software that comes with 
Dana must be installed before connecting Dana to a computer.

1. Connect one end of the USB cable to the Dana computer port.

2. Connect the other end of the cable to a USB port on the computer.

3. The computer will automatically recognize the connection



36 Introduction to Dana

Using Dana with a personal information manager 
If you are using Microsoft Outlook or other organizer software instead of 
Palm Desktop software, you still need to install HotSync Manager, and the 
connection software for your PIM, called a conduit, that lets you 
synchronize the data between Dana and your PIM. For information on 
conduit software, go to www.alphasmart.com.
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2
Entering Data 
Although you are most likely to enter data into Dana using the keyboard, 
you can also enter data by using the onscreen keyboard, writing with the 
stylus in the WritePad, or by importing data from another application.

Using the onscreen keyboard
You can open the onscreen keyboard anytime you need to enter text or 
numbers into an application. The onscreen keyboard is convenient for 
entering international characters, or entering data when the screen is 
rotated. You cannot enter Graffiti 2 characters while using the onscreen 
keyboard. 

To use the onscreen keyboard:

1. Open any application (such as the Address Book). 

2. Tap any record, or tap New.

3. Choose one of the following to display the alphabetic or numeric 
keyboard:

• Press cmd-k or tap Keyboard in the Edit menu.

• If the application is running in narrow mode, tap A in the bottom 
left corner of the WritePad to display the alphabetic keyboard. 

• If the application is running in narrow mode, tap 1 in the bottom left 
corner of the WritePad to display the numeric keyboard. 

Tap A for alphabetic keyboard. Tap 1 for numeric keypad.
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4. Once the onscreen keyboard is displayed, tap Int’l at the bottom of the 
keyboard to display the international keyboard. 

TIP: To select any of the three keyboards, tap the Menu icon and then 
tap Edit. Tap Keyboard, and then tap the keyboard you want.

5. Tap the desired characters or numbers; then tap Done to enter the text or 
numbers. 

Entering data using Graffiti 2 handwriting software
You can use Graffiti 2 strokes to create letters, numbers, punctuation, and 
symbols. Write lowercase letters on the left side of the WritePad, numbers 
on the right side, and uppercase letters across the division mark in the 
middle. 

NOTE: When using the WritePad (but not the keyboard), Dana 
automatically capitalizes the first letter of each field (except numeric and 
e-mail fields). 

Backspace

Carriage return

Tab

Caps Lock

Caps Shift

Tap here to display al-
phabetic keyboard 

Tap here to display 
numeric keyboard. 

Tap here to display 
international keyboard. 

Alpha 

Numeric International
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Learning to write Graffiti 2 characters
With only a few minutes of practice, you’ll find it easy to enter accurate 
text and numbers using Graffiti 2 writing strokes. 

The Graffiti 2 demo shows how to use the handwriting software. Tap on 
the Graffiti 2 application icon in the Applications Launcher to view the 
demo at any time.

TIP: When you reach the Stroke Lookup screen of the demo, use the 
pick list to view the wide variety of characters that you can make. As you 
tap a character, you will see an animation of the strokes used to form 
that character.

General Guidelines for Graffiti 2 Writing
Follow these guidelines to learn and use Graffiti 2 writing strokes 
successfully: 

• To achieve 100% accuracy, practice drawing characters exactly as 
they appear in the tables later in this chapter.

• The heavy dot on each shape indicates where to start the stroke. 
Some characters have similar shapes, but different starting and 
ending points. Always start the stroke at the heavy dot. (Do not 
draw the heavy dot; it is there only as a guideline.) 

• The Graffiti 2 writing strokes for letters closely resemble letters of 
the standard English alphabet, both upper case and lower case. 
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Graffiti 2 includes symbols made with a single stroke and symbols 
made with multiple strokes.

For multi-stroke characters, a temporary character is displayed after 
the first stroke, to show that the stroke was recognized. For 
example, after the first vertical stroke of “t”, a temporary “l” is 
shown. There is a limited time window, during which the second 
stroke must be drawn. Otherwise the temporary stroke is recorded.

• The WritePad is divided into two parts, one for writing lowercase 
letters and one for writing numbers. The small marks at the top and 
bottom of the WritePad indicate the division line. Write lowercase 
letters on the left side of the WritePad, numbers on the right side, 
and uppercase letters across the division line. 

To write Graffiti 2 letters:

1. In any application that runs in narrow mode or if the screen is rotated, 
tap the screen where you want to write text.

NOTE: A blinking cursor must appear in the application before you can 
begin writing text. 

Write letters here Write numbers here

Write upper case letters here
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2. Use the tables on the following pages to find the stroke shape for the 
letter you want to write. For example, the stroke shown below creates the 
letter n. 

You use the same shape to create both the uppercase and lowercase 
letter.

3. Position the stylus in the appropriate place on the WritePad. 

4. Start your stroke at the heavy dot, and draw the stroke shape as it 
appears in the tables.

5. Lift the stylus from the screen at the end of the stroke shape.

6. Dana recognizes your stroke immediately and displays the letter where 
the blinking cursor is onscreen. As soon as you lift the stylus from the 
screen, you can begin the stroke for the next character you want to write.

Graffiti 2 tips
When using Graffiti 2 writing, keep the following tips in mind:

• For greater accuracy, draw letters with large strokes; strokes that 
nearly fill the WritePad are easily interpreted. 

• To delete characters, set the cursor to the right of the character you 
want to delete, and draw the Backspace stroke (a line from right to 
left) in the WritePad.

• Write at natural speed. Writing too slowly can produce errors.

• Do not write at a slant. Keep vertical strokes parallel to the sides of 
the WritePad.

• When letters and numbers can be written using two different 
strokes, use the one that’s easiest for you. 

• Press firmly.

Start stroke at 
heavy dot.

Lift stylus here.
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Graffiti 2 Character Set: Letters and Punctuation
The following charts show how to write Graffiti 2 letters and punctuation. 
Begin each stroke at the heavy dot.

• All four strokes listed for the letter “j” can be used to create a 
lowercase “j”, but only the last two strokes (without the dot) can be 
used to create an uppercase “J”.

Writing capital letters
Graffiti 2 writing automatically capitalizes the first letter of a new record. 
To write additional capital letters, write the desired character stroke across 
the division mark in the middle of the WritePad.

Writing punctuation marks and other special 
characters
Using Graffiti 2 writing, you can create any punctuation symbol and 
special character available from a standard keyboard. 

• The period and comma punctuation marks can be written on either 
side of the WritePad (the letter or number side). Other common 
punctuation marks can be written on one side of the WritePad 
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according to the chart below (in general, the more frequently used 
punctuation is on the left side).

Note that the punctuation characters can also be entered anywhere 
on the WritePad if you first use the shift character. This requires an 
additional shift stroke, but you may find it more convenient, since 
you don’t have to remember on which side of the input area to make 
the stroke.

• Symbols and other special characters can be written using the Shift 
command. When you make a vertical stroke from the bottom to the 
top of the WritePad, the Shift indicator arrow appears in the lower 
right corner of the screen. While this arrow is visible, you can make 
the punctuation shift characters shown in the illustration below. 
Once the arrow goes away, the punctuation mark appears.

TIP: Using an additional Shift stroke to finish writing the character (as 
shown in the demo) is optional, but will make the character appear more 
quickly.

Shift
Stroke
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Draw punctuation or symbols using the following strokes:

TIP: Samples of the character strokes are available in the Graffiti 2 
Help file. To view the Help file, use the full-screen pen stroke, dragging 
the stylus from the WritePad to the top of the screen. Note that the 
accented characters appear on a Punctuation Shift Help screen, but do 
not use the Shift command. 

Writing accented characters
When writing letters with accent marks, first write the letter stroke on the 
left side (or in the center for uppercase letters) of the input area. Then 
quickly write the accent stroke on the right side of the input area, as shown 
in the illustration below.
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Graffiti 2 Character Set: Numbers
To write numbers using Graffiti 2 strokes, draw in the right side of the 
WritePad.

Writing symbols and extended characters
To create the characters in the extended character set, draw an upward 
stroke, then a symbol shown in the table below, then another upward 
stroke. An upward stroke looks like this:

Upward
Stroke
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Graffiti 2 Extended Character Set
Draw symbols or extended characters using the following strokes:
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Using the Graffiti 2 tuner
The Graffiti 2 tuner provides alternate strokes for making the T, P, Y, and $ 
characters. For example, you may want to form the letter “T” by using 
strokes similar to a space and an “L”. But if this technique is difficult to 
control, you can turn off this option.

To use the tuner:

1. Press the apps key.

2. In the pick list in the upper right corner of the screen, tap Main or 
System.

3. Tap on the Prefs icon.

4. Select Graffiti 2 from the pick list in the upper right corner of the screen.

5. Tap the letter you want to tune.
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Using Graffiti 2 Gestures
Gestures are editing commands, such as cut, paste, and the ShortCut 
command which will be explained in the next section. To use gestures, 
draw the following strokes:

Using Graffiti 2 ShortCuts
Graffiti 2 ShortCuts let you quickly and easily enter commonly used words 
or phrases. ShortCuts are similar to the Glossary or Autotext features of 
some word processors. Graffiti 2 writing comes with several predefined 
ShortCuts. You can also create your own, for any words, letters, or 
numbers.

You can create ShortCuts, with up to 45 characters, using the ShortCut 
preferences. For example, you could create a ShortCut for your name or for 
the header of a memo. All ShortCuts you create appear on the list in the 
ShortCut Preferences screen, are available in any of your electronic 
notebook applications, and are backed up on your computer when you 
perform a HotSync operation.

Your electronic notebook includes the following predefined Graffiti 2 
ShortCuts for common entries:

• ds—Date stamp

• ts—Time stamp

• dts—Date/time stamp

• me—Meeting

• br—Breakfast

• lu—Lunch
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• di—Dinner

To use a ShortCut:

Press function-  or function-apps (the ShortCut key is the secondary 
function on the apps key) or draw the ShortCut stroke followed by the 
ShortCut character or characters. For example, to enter the ShortCut for 
Breakfast press function-apps and then type br.

When you press function-apps or draw the ShortCut stroke, the ShortCut 
symbol appears where the blinking cursor is onscreen.

To create a ShortCut:

1. Press the apps key.

2. Select All or System from the pick list in the upper right corner.

3. Tap the Prefs icon.

4. Tap ShortCuts in the pick list in the upper right corner. 

5. Tap New.

6. In the ShortCut Name line of the ShortCut Entry screen, enter the letters 
you want to use to activate the ShortCut.

ShortCut
   

ShortCut symbol
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7. Tap the ShortCut Text area, then enter the text that will appear when you 
write the ShortCut characters. 

8. You can add a space character after the last word in your ShortCut text, 
so that a space automatically follows the ShortCut text.

9. Tap OK.

To edit a ShortCut:

1. In the ShortCut Preferences screen, tap the ShortCut you want to edit.

2. Tap Edit.

3. Make the changes you want; then tap OK.

To delete a ShortCut:

In the ShortCut Preferences screen, tap the ShortCut you want to delete.

Tap Delete; then tap Yes.

Entering data on your computer
At times, you may prefer to enter information or add new records to your 
computer rather than your electronic notebook.

You can enter information in your computer, using Palm Desktop ™ or any 
supported personal information manager (PIM) installed for use with your 
electronic notebook. You can then perform a HotSync® operation to 
synchronize the information on your computer with the information on 
your electronic notebook. Most of the main applications on Dana are 
available in Palm Desktop software and in most PIMs.

Refer to Palm Desktop online Help for more information on entering data 
on your computer.

Tap New.
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Importing data
If you have data stored in computer applications such as spreadsheets and 
databases, or if you want to import data from another device, you can 
transfer the data to Dana without having to key it in manually. Save the 
data in one of the file formats listed below, import it into Palm Desktop 
software, and then perform a HotSync operation to transfer the data to 
your electronic notebook.

Palm Desktop software can import data in the following file formats: 

• Comma delimited (.csv,.txt): Address Book and Memo Pad only.

• Tab delimited (.tab,.tsv,.txt): Address Book and Memo Pad only.

• CSV (Lotus Organizer 2.x/97 Mapping): Address Book only.

• Date Book archive (.dba).

• Address Book archive (.aba).

• To Do List archive (.tda).

• Memo Pad archive (.mpa).

Archive formats can only be used with Palm Desktop software. Use the 
archive file formats to share information with other people who use 
devices based on the Palm Computing® platform or to create a copy of your 
important Palm Desktop information.

To import data:

1. Open Palm Desktop software.

2. Click the application into which you want to import data.

3. If you are importing records that contain a field with category names, do 
the following:

• Select All in the Category box.

• Make sure that the same categories that appear in the imported file 
also exist in the application. If the categories do not exist, create 
them now; otherwise, the records will be imported into the Unfiled 
category.

4. Choose File > Import; then select the file you want to import, and click 
Open. 
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5. To import data into the correct Palm Desktop fields, drag fields in the 
left column so that they are opposite the corresponding imported field 
on the right.

6. To exclude a field from being imported, deselect the field’s check box. 

7. Click OK.

8. The imported data is highlighted in the application.

9. To add the imported data to your electronic notebook, perform a 
HotSync operation.

See Palm Desktop online Help for more information on importing and 
exporting data.
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3
Managing Applications
This chapter explains how to switch between applications on Dana, how to 
personalize application settings, and how to categorize applications into 
related groups. 

Using the Applications Launcher
The Applications Launcher displays all the available applications on your 
electronic notebook by default. You can also display only selected 
applications by arranging applications into categories. 

To open the Applications Launcher:

Press the apps key or tap the Applications icon .

Selecting applications
Your electronic notebook is equipped with a variety of applications. All the 
applications installed on Dana appear in the Applications Launcher. 

In addition to providing a way for you to open applications, the 
Applications Launcher displays the current time, battery level, and 
application category. 

To open an application:

Choose from the following options:

• Press the apps key, and then use the arrow keys to move the 
selection box between applications, or the Tab key to cycle through 
all the applications from left to right. Once selected, any application 
can be launched by pressing the enter key.

• You can also select an application by typing the first letter of an 
application’s name, which will jump you to the application. If more 
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than one application starts with the same letter, than type the first 
few letters of the one you want to select.

• Tap the Applications icon, and then tap the icon of the application 
you want to open. If you have many applications installed on Dana, 
tap the scroll bar to see all the available applications. 

• Press an application key on the top right row of keys to display the 
selected application immediately. 

• To switch between applications, tap the Applications icon or press 
an application key. Dana automatically saves your work in the 
current application and displays it when you return to that 
application.

Categorizing applications
The category feature enables you to manage the number of application 
icons that appear onscreen in the Applications Launcher. You can assign an 
application to a category and then display a single category or all your 
applications. 

To categorize an application: 

1. Press the apps key. 

2. Press the menu key or tap the Menu icon . 

3. From the App menu, tap Category. 

4. Choose from the following options: 

• To choose a category for an application, tap the pick list next to each 
application.

• To create a new category for an application, tap Edit Categories 
from the application’s pick list. Tap New, enter the category name, 
and then tap OK to add the category. Tap OK.

Tap arrow to show pick list



Dana User’s Guide 55

5. Tap Done.

To display applications by category: 

1. Press the apps key. 

2. Do one of the following:

• Tap the Applications icon or apps key repeatedly to cycle through 
all the categories.

• Tap the pick list in the upper right corner of the screen; then tap the 
category you want to display.

Changing the Applications Launcher Preferences
By default, the Applications Launcher displays applications as icons. As an 
alternative, you can display applications in a list format. You can also set 
an option to display the last-selected category of applications each time 
you open the Applications Launcher, as well as options that govern the 
behavior of the selection box and the type-select emulation. 

To change the view of applications: 

1. Press the apps key; then tap the Menu icon. 

2. From the Options menu, tap Preferences. 

3. From the View By option tap List; then tap OK to see your applications 
in list format. 
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To display the last-selected category of applications:

1. In the Preferences dialog box, tap Remember Last Category.

2. Tap OK. Each time you return to the Applications Launcher, the last 
category of applications you selected is displayed. 

NOTE: If you do not select the Remember Last Category option, all 
applications are displayed when you select the Applications Launcher. 

Changing Selection Box behavior
When Selection Box always in view is checked, moving to a different 
screen in the Application Launcher will move the selection box to an 
application that is in the new screen. When Selection Box always in view is 
unchecked, the same application will remain selected as you navigate 
around in the Application Launcher even if the application is not in the 
current screen.

To change selection box behavior: 

1. In the Preferences dialog box, tap Selection Box always is view. 

2. Tap OK. 

Changing Type-select emulation
When Mac type-select emulation is enabled, typing the first letter of an 
application always selects the first application that starts with that letter. 
For example, if you have applications called Prefs, PrintBoy, and 
PrintSetup, typing "p" will always select Prefs. When PC type-select 
emulation is enabled typing the first letter of an application multiple times 
will cycle through all the applications that starts with that letter. Using the 
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example above, typing "p" multiple times would first select Prefs, then 
PrintBoy, and lastly PrintSetup.

To set type-select emulation: 

1. In the Preferences dialog box, tap either Mac or PC. 

2. Tap OK. 

Installing additional applications
In addition to the applications that came with Dana, you can install a 
variety of other add-on applications using the Install Tool during a 
HotSync® operation. To learn more about additional applications for Dana, 
go to www.alphasmart.com. 

Any additional applications you install reside in RAM memory and can be 
removed at any time; for information, "Removing applications" on page 58.

To install additional applications on Dana:

1. From your computer desktop, copy or download the applications you 
want to install into the add-on folder in your Palm Desktop directory.

2. If the application is compressed, for example, as a .zip file, decompress 
the application into the add-on folder before continuing.

3. Double-click the Palm Desktop icon on your computer desktop to open 
it; then click Install. 

TIP: You can also select the Install Tool dialog box by selecting Install 
Tool from the Palm Desktop program group or by double-clicking any file 
with a PRC file extension.
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4. In the User drop-down list, select the user name that corresponds to your 
electronic notebook; then click Add. 

5. In the file list of the Add-on folder, select the application that you want 
to install on your Dana; then click Open. The file appears in the Palm 
Install Tool dialog box. 

6. If decide not to install an application, select it in the list of files in the 
Palm Install Tool dialog box and click Remove. The application is 
removed from the dialog box list, but not from your computer. 

7. Click Done. A message appears to indicate that the application or 
applications will be installed the next time you perform a HotSync 
operation. 

8. Perform a HotSync operation to install the applications.See "Exchanging 
and Updating Data using HotSync® Operations" on page 179 for more 
information.

Removing applications
You can remove add-on applications, patches, and extensions from your 
electronic notebook if you run out of memory or no longer need them.

You cannot remove the built-in applications that reside in the ROM portion 
of your device, including the Date Book, Address Book, To Do List, Memo 
Pad, Calculator, and AlphaWord applications.
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To remove an add-on application: 

1. Press the apps key; then tap the Menu icon. 

2. From the App menu, tap Delete.

3. In the Delete dialog box, tap the application you want to remove. 

4. Tap Delete.

5. Tap Yes.

6. Tap Done.

Removing Palm Desktop software 
If you no longer want to use Palm Desktop software, you can remove it 
from your computer. 

To remove Palm Desktop software: 

1. In Windows, from the Start menu, choose Settings > Control Panel.

2. Open the Add/Remove Programs icon. 

3. On the Install/Uninstall tab, select Palm Desktop software; then click 
Add/Remove. 

NOTE: You must retain the HotSync Manager from the installation CD 
to synchronize data with another PIM.
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Assigning security options
A Security application is available to users who have the Dana 
Productivity Pack that lets you set options to protect entries from 
unauthorized users in a variety of ways. 

The Security application lets you: 

• Mask or hide entries you have defined as private. The Mask option 
displays a gray bar over private records, and the Hide option 
completely removes (hides) private records. 

• Assign a password to viewing options to enhance security. 
Assigning a password requires you to enter a password before 
private entries can be viewed; not assigning a password lets you 
view private entries when you Show Records from the Security 
dialog box. 

• Lock and turn off your electronic notebook so that a password must 
be entered before you can use the device again. 

• Hide records that you have defined as private, with or without a 
password. Without a password, private records are hidden until 
you set the Security application to display them; with a password, 
you must enter the password to view the private entries.

Masking and hiding records
You can mask or hide private records. When you mask private records, a 
visual placeholder appears where the record would normally be displayed; 
when you hide records, they are not visible anywhere in the list. 

To mask private records:

1. Make sure that the record or records you want to mask are defined as 
private. To make a record private, select the record, tap Edit, tap Details, 
and then tap the Private option. 

2. From the Applications launcher, tap Security.
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3. From the Current Privacy pick list, tap Mask Records. 

4. Open one of the basic applications and view a record. Records marked as 
private are masked with a gray bar. 

To hide private records:

1. Make sure that the record or records you want to hide are defined as 
private. To make a record private, select the record, tap Edit, tap Details, 
and then tap the Private option. 

2. From the Applications launcher, tap Security.

3. From the Current Privacy pick list, tap Hide Records.

4. When you return to the Address Book, records marked as private are not 
included in the display of names.

Note that you can mask or hide records without assigning a password, or 
you can assign a password if you want records to remain masked or 
hidden until a password is entered. 

Assigning and editing passwords
You can assign a password to protect private records and to lock Dana.

Once you define a password, you can change or delete it at any time. You 
must enter the current password before you can change or delete it. 

If you’ve forgotten your password, you can delete it. See "Recovering from 
a forgotten password" on page 63.

To assign, change, or delete a password:

1. From the Applications launcher, tap Security.
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2. Tap the Password box. 

3. Enter a password—either the one you want to assign or your current 
password if you want to change or delete it—and tap OK

4. Choose from the following options:

• To assign a password, enter the password again to verify it, and tap 
OK. 

• To change your password, enter a new password and tap OK.

• To delete your password, enter your current password. Tap OK, 
and then tap Unassign.

Locking Dana
You can turn off and lock Dana with a password to protect information. 
You must then enter the password when you turn on Dana to gain access to 
the information on it. 

If you forget the password, you must perform a hard reset to resume using 
Dana. Performing a hard reset deletes all the records in Dana; however, 
you can restore all synchronized data at the next HotSync operation. See 
"Performing a hard reset" on page 211 for more information. 

To lock Dana with a password:

1. Assign a password, as described in "Assigning and editing passwords" 
on page 61. 

A password is required before using the Turn Off & Lock option.

2. Tap Lock & Turn Off. The System Lockout dialog box appears. 

3. Tap Off & Lock. You device is turned off and is locked. 
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To turn on and unlock Dana:

1. Turn on your device. 

2. Enter your password at the prompt; then tap OK. 

Recovering from a forgotten password
If the Off & Lock option is not active, and you forget your password, you 
can delete the forgotten password from Dana. Deleting a forgotten 
password also deletes all entries and files marked as Private.

IMPORTANT: If you synchronize with your computer before deleting a 
forgotten password, Dana restores private entries the next time you 
perform a HotSync, but does not restore the forgotten password. 

To delete a forgotten password:

1. From the Applications Launcher, tap the Security icon. 

2. From the Security dialog box, tap the Password box.

3. Tap Lost Password.

4. A message appears; tap Yes to delete the forgotten password. 
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4
AlphaWord
AlphaWord is a full-featured word processor that lets you create, format 
(including setting fonts, justification, line spacing, indents), and edit 
documents. These documents can then be printed or transferred to a 
computer via a USB cable or a wireless connection.This chapter will cover 
the fundamentals of AlphaWord

AlphaWord Basics

Files 1-8
In AlphaWord you are always in one of eight workspaces that you can 
instantly access using their corresponding file keys (F1-F8). You can use the 
workspaces for your work in progress. When you press one of the file keys 
in AlphaWord, the associated file immediately opens. This eliminates 
having to scroll through a long list of files to find the one you want to open. 
If there is no file associated with the file key you pressed, then a new file is 
created.

TIP: To replace a file associated with a workspace with a different file, 
press the menu key, then select File New for a new file or File Open for 
an existing file. The file that you open will now be associated with the 
workspace that is being used.
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Creating an AlphaWord document
1. Press the memo key or tap the AlphaWord icon in the Applications 

Launcher.

2. If there are no existing files, AlphaWord will automatically open a new 
file, otherwise select New under the File menu. 

NOTE: The first time you start AlphaWord it will automatically open a 
new file, otherwise it will go to the file you were in last. Press one of the 
F1-F8 keys, to go to the file associated with that workspace.

3. Enter the text you want to appear in the document.

NOTE: To use Tab in documents see "Tab Movement" on page 171.

4. Use the buttons on the toolbar to add formatting including setting fonts, 
justification, line spacing, indents etc.

5. To name your file, choose Save As under the File menu

NOTE: Once you’ve named your file, AlphaWord automatically saves it 
when you leave AlphaWord or open another file, so you don’t need to 
worry about losing your data.

6. Enter a name for the new document, and the press function-ok.



Dana User’s Guide 67

Editing an existing AlphaWord document
1. If the file you want to open is associated with a workspace, then just 

press the appropriate file key (F1-F8) to open the file.

2. If the file you want to open is not associated with a workspace, press the 
menu key. Select Open under the File menu.

3. Use the up or down arrow key to highlight the document you want to 
view or edit, then press the enter key.

Deleting a document
1. Open the file you want to delete.

2. Press the menu key. Select Delete Doc under the File menu.

3. Press function-ok.

Using Spell Check
1. Create a document or open an existing document.

2. Press the menu key. Under the Edit menu tap Check Spelling.

NOTE: The larger data file for the Spell Checker that contains more 
words(AWSpellLarge.pdb) should be automatically installed the first time 
you HotSync. To check if it is installed: press the apps key, then press 
the menu key and select Info under the App menu. If SpellData is in the 
list, then the larger data file is installed. If it isn't, you can HotSync it to 
Dana now. AWSpellLarge.pdb is located in the DanaExtras folder under 
the Palm folder on your computer. For more information on HotSyncing 
the file to Dana, see "Installing additional applications" on page 57.

 Tap a document to edit its contents

 

 
 Indicates 
which file 
key the file 
is mapped 
to
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3. Tap the selection you want to spell check.

TIP: To bypass this menu, select the text you want to spell check 
before choosing Check Spelling from the menu.

4. Tap the appropriate button.

Supplemental dictionary

AlphaWord allows you to create supplemental dictionaries that you can 
add words to using the Add button in Spell Checker. Spell Checker then 
includes these words in the list of words it recognizes, so the added words 
won’t be marked as misspelled. You can also edit a supplemental 
dictionary directly and add a misspelled word and its corresponding 
correctly-spelled replacement word. You might find it useful to create 
dictionaries with medical terms, scientific terms, or even proper names you 
use frequently. Up to two supplemental dictionaries can be active at a time. 
AlphaWord comes with a dictionary for you to add words to, or you can 
create a new dictionary and name it what you like.

Selecting a supplemental dictionary

1. Press the menu key.

2. Under the Options menu, select User Dictionary.

Underline indicates 
misspelled word

Tap Edit to type 
in a word.

Tap Opt...to change 
Spell Checker 
options.

Tap Add to add the word to a 
supplemental dictionary.

Select the correct word in 
the list, then tap Change 
to replace the misspelled 
word. Tap All to replace 
all instances of the word 
in the document.

Tap Ignore to skip the 
word and continue checking 
the document. Tap All to 
ignore all instances of the 
word in the document.
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3. Select the dictionary you want to use.

4. Tap OK.

Editing a supplemental dictionary

1. Press the menu key.

2. Under the Options menu, select User Dictionary.

3. Tap the Edit button.

4. Tap the appropriate button.

5. Tap OK.

Editing words in a supplemental dictionary

1. Press the menu key.

2. Under the Options menu, select User Dictionary.

3. Tap the Edit button.

4. Select the dictionary you want to add words to in the dictionary list.

5. Tap the Edit Words button.

6. Type the misspelled word you want to check for in Checked Word.

Tap arrow to choose a 
different dictionary

Tap to create, rename, 
delete, or add words to a 
dictionary

Tap to create a new dictionary

Select the dictionary you 
want to delete in the list 
and then tap Delete
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7. Type the correctly spelled word in Replace With.

8. Tap the Add Words button.

9. To add additional words type over the text in Checked Word and 
Replace With, and then tap the Add Words button.

10. Tap Done. Tap Done. Tap OK.

Using Thesaurus
1. Create a document or open an existing document.

2. Select the word for which you want to find a synonym.

3. Press the menu key. Under the Edit menu tap Thesaurus.

Type the misspelled 
word to check for

Type in the correctly 
spelled word here

Select the word pair you 
want to delete in the list 
and then tap Delete Words

Tap Add Words to add the 
word pair to the dictionary
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NOTE: The data file for the Thesaurus (ThesData.PDB) should be 
automatically installed the first time you HotSync. If it isn’t, you can 
HotSync it to Dana now. It can be found in the DanaExtras folder under 
the Palm folder on your computer. For more information, see "Installing 
additional applications" on page 57.

4. Tap the appropriate button.

Using Find
1. Create a document or open an existing document.

2. Press the find key. 

3. Enter the text you want to find.

• Match case: Check if you want to only find instances where the case 
is exactly the same (i.e. if you search for “Dana”, then it won’t find 
“dana”).

• Whole word only: Check if you want to only find instances where 
the entire word is the same (i.e. if you search for “sin”, then it won’t 
find “sincere”).

Choose the 
type of word 
you want

Select a word in the 
synonym list, and then 
tap Apply for it to 
replace the original word

Select a word in the synonym 
list, and then tap Lookup to 
find synonyms for it

Enter the text you 
want to find

Check here and then 
enter the text to use 
as a replacement

Check here to start 
looking from start of 
the file. 
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• Search from beginning of file: Check if you want to start the search 
at the beginning of the file. Otherwise, find will start looking at the 
current cursor position.

4. To replace the text, check the Replace: box and enter the replace text. Tap 
OK. 

Printing Setup
1. Press the apps key repeatedly till you see ALL in the top right corner of 

the Applications Launcher.

2. Tap the Print icon.

3. Tap the Setup button.

4. Choose your printer from the Printer pick list.

5. Tap the Set As Default button.

Enter the text that you 
want to replace the 
found text

Check All if you 
want to replace all 
instances of the 
found text

You must tap here 
after selecting your 
printer to save your 
settings
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6. Tap the Edit button.

7. Choose IrDA or USB from the Port: pick list. Tap OK.

IMPORTANT: You must tap OK on this screen for Dana to print.

8. Tap OK.

Printing 
Dana comes with PrintBoy Anywhere which lets you print from 
AlphaWord as well as other applications. For more information on printing 
from other applications see "Printing records" on page 134.

1. Open the document you want to print in AlphaWord.

2. If you are printing via USB, connect one end of the USB cable to the 
Dana printer port and connect the other end of the cable to the printer. If 
you are printing via infrared (IrDA), point Dana’s IrDA port at the 
Printer’s IrDA port. 

3. Press the menu key. Under the File menu tap Print.

4. Tap checkbox if needed, and then tap the Print button.

Tap pick list to 
change port

Tap to change the 
page size Tap to change the 

left margin

Tap to enable printing 
of header with file 
name and date

Tap to disable printing 
of page numbers
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Printing directly from PrintBoy
1. Press the apps key repeatedly till you see ALL in the top right corner of 

the Applications Launcher.

2. Tap on the Print icon.

3. Tap on Documents.

4. Select AlphaWord from the document type pick list.

5. Tap the document you want to print, then tap the print button.

Connecting to your Computer

Send versus HotSync
AlphaWord gives you two options for transferring information to a 
desktop computer. HotSync will transfer your document and preserve its 
formatting (fonts, justification, line spacing, indents etc.) The document 

Tap to view printable 
documents 

Tap pick list and select 
AlphaWord

Tap a document to print

Uncheck to turn off printing of 
headers and page numbers.
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can then be opened in any application that can read RTF files (Rich Text 
Format) including Microsoft Word, WordPad, AppleWorks etc. Send will 
send plain text (no formatting) to any application that accepts text. HotSync 
works with a USB connection, while Send works with either a USB or 
wireless (IrDA) connection. When using a wireless connection the text is 
first transferred to AlphaBeam, and then pasted into the application 
running in the top (or foreground) window.

HotSync a new AlphaWord document to your 
computer

1. Create and save a document in AlphaWord.

2. Press the apps key to go to the Applications Launcher (home).

3. Connect Dana to your computer via a USB cable, then press function-
sync.

4. HotSync will put the new document in your My Documents folder (PC) 
or the AlphaWord folder inside your Palm user folder inside the Palm 
desktop folder under Documents (Macintosh). 

NOTE: If you specified a different folder for AlphaWord documents in 
AlphaWord Sync preferences, Hotsync will put your documents there. 

5. To open a document, launch AlphaWord Sync on your computer, select a 
document and double-click on it.

WARNING! By default if you have edited a document on your desktop 
and Dana, HotSync treats the document on Dana as the latest version of 
the document, and backs up the version on your desktop. For more 
information on synchronization see the "HotSync In-depth" on page 84.

Send text from Dana to your computer
To send text without formatting (such as fonts, justification, spacing, etc.) 
to an application on your PC or Macintosh, follow these steps: 

1. On a PC or Macintosh start up any application that accepts text, and open 
a new file.
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NOTE: If you are doing a wireless text transfer, launch AlphaBeam on 
your computer. For more information see "Installing AlphaBeam" on 
page 32. 

2. On Dana open the document you want to transfer.

3. Connect Dana to your computer via a USB cable or point Dana’s infrared 
port at your computer’s IrDA port, then press send.

4. The text will appear in the application on the Macintosh or PC. 

NOTE: Note: For wireless (IrDA) transfer there is file size limit of 50K 
on a PC and 32K on a Macintosh.

HotSync a desktop document to AlphaWord
On a PC you can HotSync any Microsoft Word or RTF (Rich Text Format) 
file. On a Macintosh you can HotSync any RTF file. Text files on a 
Macintosh or a PC must be converted to the correct format before they can 
be transferred to AlphaWord.

TIP: To convert a file to RTF (Rich Text Format) use the File Save As 
command (found in most word processors). Open the file in your word 
processor and choose File Save As.
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1. Launch AlphaWord Sync on your computer.

2. To select which document(s) will be sent to AlphaWord either:

• Drag-and-drop the document onto the AlphaWord Sync window.

• In AlphaWord Sync use the Add button to select a document.

3. Press the apps key.

4. Connect Dana to your computer via a USB cable, then press function-
sync.

5. When HotSync is done, the document will be in the AlphaWord file list. 
Select Open under the File menu to view the document in AlphaWord.

Tap Add to 
select a 
document
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AlphaWord In-depth

AlphaWord controls

• Paragraph formatting button  Bring up paragraph formatting 
box (covers justification, indenting, bulleted lists, line spacing etc.) 

• Justification button  Indicates whether the memo is left, right or 
full justified or centered. Tap to change the justification. 

• Bold button  Turns on bold. Highlighted if enabled.

• Underline button  Turns on underline. Highlighted if enabled.

• Italics button  Turns on italics Highlighted if enabled. 

• Fonts button  Indicates what Font type and characteristics have 
been selected. Tap to change fonts.

• Arrow  Tap the arrow in the right hand corner to hide the 
toolbar. Tap on it again to get it back.

• Scrollbar Moves the cursor up and down in the document. Slowly 
scroll by putting your stylus on the up or down arrow, or quickly 
move through the document by dragging the bar on the scrollbar.

 
 
 
 

 
 
 

Tap on the arrow to hide or 
show the toolbar

  

Tap the toolbar to access 
various formatting functions

 
 

Tap or drag Scrollbar to move through document

Shows the current 
workspace
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Cursor movement

In AlphaWord (and other Dana applications), you can move the cursor 
using the following keystrokes: 

Text selection 

You can select text by using the keyboard commands in the following table 
or using your stylus. With the stylus you can select words, sentences, or 
paragraphs. Select a word by tapping and holding in the center of the 
word. Continue holding to select the full line and then the paragraph. You 
can achieve similar results by double tapping (selects the word), triple 
tapping (selects the line), or quadruple tapping (selects the paragraph).

Table 4.1 Cursor Movement Keyboard Commands

Ctrl-Left Arrow move cursor to the previous word 

Ctrl-Right Arrow move cursor to the next word 

Cmd-Left Arrow move cursor to the beginning of the line 

Cmd-Right Arrow move cursor to the end of the line 

Cmd-T move cursor to the top of the document

Cmd-E move cursor to the bottom of the document

Table 4.2 Text Selection Keyboard Commands

Shift-Left Arrow select one character to the left 

Shift-Right Arrow select one character to the right 

Ctrl-Shift-Left Arrow select previous word 

Ctrl-Shift-Right Arrow select next word 

Shift-Up Arrow select the previous line 

Shift-Down Arrow select the next line 
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Cut, copy, paste and select

These commands are equivalent to those used on PCs or Macintosh: 

Changing Paragraph formatting
Paragraph formatting allows you to set justification, line and paragraph 
spacing, indents, and turn on a bullet list. 

1. Tap the Paragraph formatting button  in the toolbar or press cmd-G.

2. Tap the Spacing tab to set the line or paragraph spacing.

Table 4.3 Text Manipulation Keyboard Commands

Ctrl-C or cmd-C copy selected text into the clipboard 

Ctrl-V or cmd-V paste the text from the clipboard 

Ctrl-X or cmd-X cut selected text into the clipboard 

Ctrl-A or cmd-A select all text in the current text field or document

Ctrl-backspace deletes previous word

Ctrl-del deletes next word

 

 
Tap an icon to change the 
justification

Tap checkbox to 
display text as a 
bulleted list

Tap the arrows or 
type in a number to 
change the right or 
left indent Tap the arrow to specify a 

first or hanging indent

 

 

Tap to switch between tabs

Tap the arrows or type in a 
number to change the spacing 
before or after a paragraph

Tap the arrow to 
change the spacing 
between lines
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3. Tap OK.

Reflow

Selecting Edit Reflow will take out every line break that is not followed by 
a blank line. AlphaWord will automatically recommend a reflow if there is 
not at least one paragraph in a document that is 8K or larger.

1. Select the text you want to reflow.

TIP: To reflow an entire document, choose Edit Select All, then reflow.

2. Press cmd-2 or select Reflow under the Format menu.

Installing additional display fonts on Dana
AlphaWord allows you to add additional display fonts to use in your 
documents to improve their appearance and on-screen readability.

1.  Launch FineType Converter on your PC. FineType Converter is 
automatically installed on you desktop when you install Palm Desktop 
Software.
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NOTE: For Macintosh Users: FineType Converter is only available for 
Windows. If you have access to a PC, we suggest installing fonts from 
there or if you have a Dana device you’ve already installed the fonts on 
from a PC, you can beam them between Danas.

2. Click on the font name you want to install, then click on the Install 
button. 

TIP: To select multiple fonts, hold down the Ctrl key while clicking the 
fonts.

3. HotSync to install the selected fonts on Dana.

Advanced Font Features
The advanced font features lets you further customize the fonts listed in 
the FineType Converter dialog.

1.  Launch FineType Converter on your PC.

Click or Ctrl-click to 
select fonts
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2. Click the Advanced... button.

3. Click on the font name you want to customize, then adjust the width 
(how wide the character is) and weight (how dark the character is). To 
return to the default width and weight for a particular font click the 
Defaults button.

4. Click the Save button to save the customized font, then click on the 
Install button. 

5. HotSync to install the selected fonts on Dana.

Using Fonts in AlphaWord
1. Open the document whose fonts you want to change.

2. Tap the fonts button on the toolbar or choose Font from the Format 
menu.

3. Choose a font from the Font pick list.

4. Tap the OK button.

 

 

 Tap the Font pick list to 
change fonts - Installed 
fonts are shown in bold

 

 

 Check a box to change 
font attributes

 Tap arrows to change font 
size or type in a number 
between 4 and 127

 Shows what the 
selected font will 
look like
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NOTE: A font may appear in the Font: list, but not display in 
AlphaWord or the Sample box. A font will only display if the actual font 
has been installed on Dana. Installed fonts are shown in bold in the Font: 
list. If you choose a font that is not installed on Dana, but is installed on 
your computer, when you send the document back to your computer the 
font will display.

HotSync In-depth

Synchronization and Backup

This section describes in detail how AlphaWord HotSync works. For the 
purpose of this example, lets start with a document on your desktop called 
“researchpaper”. When AlphaWord synchronizes researchpaper to Dana, 
nothing happens to the copy of researchpaper on your desktop. 
researchpaper will only be altered on your desktop if you edit and save 
researchpaper on Dana, and then synchronize the revised document back 
to your desktop. At this point, AlphaWord will create the following 2 files 
on your desktop.

• researchpaper.doc (or researchpaper.rtf on a Macintosh) - the 
revised document that you just synchronized from Dana to your 
desktop 

• researchpaper-orig.doc (or with an .rtf extension on a Macintosh) - 
this is a copy of the unedited, original researchpaper.

In the event of a conflict situation where you have edited researchpaper on 
Dana and your desktop, AlphaWord will conclude that the version on 
Dana is the most recent version. In this case, AlphaWord will make a copy 
of the revised document on your desktop and call it researchpaper-
back.doc (or .rtf).

The researchpaper-orig.doc (or .rtf) and researchpaper-back.doc (or .rtf) 
files are saved in the same location as the original researchpaper document.

AlphaWord Sync

As mentioned earlier AlphaWord Sync can be used for adding documents 
to HotSync and launching documents. AlphaWord Sync can also be used to 
move documents, remove documents from the HotSync list, change 
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preferences, and on a PC print the document, open the original, or open the 
backup. 

1. Launch AlphaWord Sync on your computer.

2. Select a document in the list and click the appropriate button to:

• Remove: Removes the document from the list to HotSync to Dana. If 
the document has already been synchronized to Dana, you will be 
given the option for AlphaWord to delete the document from Dana.

• Move: Moves the document (and its original and backup copies if 
applicable) from one folder to another. 

3. Or on a PC right click on the document name to bring up a popup menu.

Open Original and Open Backup refer to copies of the document that 
were made during earlier HotSync operations. See Synchronization and 
Backup above for more details.
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4. Click the Preferences button.

5. Click the appropriate control described below to:

• Change the default directory for documents created on Dana. This is 
the directory on your computer where documents created on Dana 
are saved when you HotSync.

• On a PC you can also choose to save your documents with either a 
.doc or .rtf extension. For word processors other than Microsoft 
Word, .rtf is probably the best choice.

• AlphaWord doesn’t normally preserve stylesheets because it would 
require a lot of memory on Dana. If you want to preserve stylesheets 
select the Always option or Ask option (where you are asked if you 
want to preserve stylesheets every time you HotSync).

• AlphaWord doesn’t normally store pictures from a document on 
Dana because it would require too much memory. If you want to 
store pictures on Dana, select the Organizer or Ask options.

6. Click OK.

7. Click Done.
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5
Working with 
Applications
This chapter is organized by application and gives instructions on how to 
do tasks that are specific to each of the following applications:

• Date Book

• Address Book

• To Do List

• Memo Pad

• Calculator
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Using the Date Book
The Date Book lets you quickly and easily schedule appointments or any 
activity associated with a date or date and time. When you open the Date 
Book, the current date and a list of times for a standard business day are 
displayed. 

Use the Date Book to: 

• Schedule events: timed events, which have both times and dates; 
untimed events, for example, birthdays or anniversaries; repeating 
events, such as a weekly meeting held on the same day at the same 
time; continuous events, such as a vacation or three-day conference; 
and all day events, which reflect the default hours of a day as set by 
the user. 

• Display your schedule in different ways: by Day, Week, Month, or 
Agenda view. 

• Set an alarm to sound minutes, hours, or days before a scheduled 
appointment. 

• Attach notes to events to describe or clarify Date Book entries. 

• Rearrange or delete events from your schedule.

To open the Date Book:

Press the date key to open the Date Book to today’s schedule. The date is 
displayed at the top left of the screen. 

NOTE: Press the date key repeatedly to cycle through the Day, Week, 
Month, and Agenda views. The Date Book views are displayed at the 
bottom left of the screen.

Scheduling events
An entry in the Date Book is called an event. When you schedule an event, 
its description appears on the time line, and its duration is set to 1 hour by 
default. You can easily change the start time and duration for any event. 
You can schedule the following types of events in the Date Book:

• Timed events, such as meetings, that have a specific date and a 
specific start and end time. 
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• Untimed events, such as birthdays, holidays, and anniversaries. 
These events occur on a particular date but have no specific start or 
end times; they appear at the top of the list of times marked with a 
diamond. You can schedule more than one untimed event on the 
same date. 

• Repeating events, such as a weekly meeting that is held on the same 
day at the same time each week. 

• Continuous events, such as a vacation or three-day conference.

• All day events, which reflect the default length of the day as set by 
the user. 

Scheduling timed events

You can schedule timed events for the current date or for future dates. 

To schedule a timed event for the current date:

1. Press the date key to open the Date Book to today’s schedule. The 
current date and a list of times for a normal business day are displayed 
in Day view.

2. With the current day selected, tap the line next to the time that 
corresponds to the start of the event. 

3. Enter a description of the event, up to 255 characters in length.

4. Set the event’s duration:

• If the event is 1-hour long, skip to the end of this procedure.

• If the event is longer or shorter than an hour, tap directly on the 
time to open the Set Time dialog box.

Tap a line next to desired time; 
then enter text.

Time bar 
shows default 
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TIP: You can open the Set Time dialog box (to select a start time) by 
making sure no event is selected, and then typing a number on the 
keyboard.

5. Set the duration of the event in either of the following ways:

• Tap the time columns in the Set Time dialog box to set the Start 
Time; Tap End Time; then tap the time columns to set the End Time.

• Tap All Day if the event lasts all day. The default hours of a 
standard business day are set by the user, and may be changed 
using the Preferences command in the Date Book application. See 
the section "Changing the displayed Start and End Times" on page 
104.

Tap the time 
to display 
the Set 
Time dialog 
box.
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6. Tap OK.

To schedule a timed event for another date:

1. Select the date you want in one of the following ways: 

• Tap the desired day of the week in the date bar at the top of the 
screen. If necessary, tap the Previous week or Next week scroll 
arrows to move to another week.

• Tap Go To at the bottom of the screen to open the Go to Date dialog 
box. Select a date by tapping a year, month, and day in the calendar.

2. After locating the desired date, follow the steps for scheduling an event 
for the current day.

Scheduling untimed events

You can schedule untimed events for any date. Untimed events appear at 
the top of the list of times marked with a diamond. 

To schedule an untimed event: 

1. Select the event date you want, as described in the previous procedure, 
“To schedule a timed event for another date.” 

2. Tap New.

3. In the Set Time dialog box, tap No Time. 

NOTE: You can tap OK instead but make sure nothing is entered for 
start or end time.

Tap to scroll to 
later hours.

Start Time 
highlighted

Tap to scroll to 
earlier hours.

Tap to change 
minutes. 

Tap to change 
hours. 
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TIP: You can create a new untimed event by making sure no event is 
selected and then typing letters on the keyboard. When you start typing, 
the untimed event appears at the top of the screen 

4. Enter a description of the event.

5. Tap a blank area on the screen to deselect the untimed event.

NOTE: If you create a timed event and later want to make it an 
untimed event, tap directly on the event time on the Date Book screen; 
then tap No Time and tap OK. 

Scheduling repeating or continuous events 

The Repeat function lets you schedule events that recur at regular intervals 
or extend over a period of consecutive days. Repeating events include a 
birthday and a weekly guitar lesson that falls on the same day of the week 
and the same time of day. Continuous events might include a business trip 
or a vacation.

New 
untimed 
event
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To schedule a repeating or continuous event:

1. Tap the event (Be sure to tap the event and not the time next to the 
event.). 

Typically, a continuous event is an untimed event.

2. Tap Details.

3. Tap the Repeat box to open the Change Repeat dialog box.

4. Tap Day, Week, Month, or Year to set how often the event repeats. For a 
continuous event, tap Day.

5. Enter a number that corresponds to how often you want the event to 
repeat on the Every line. 

6. For example, if you select Month and enter the number 2, the event 
repeats every other month.

7. To set an end date for the repeating or continuous event, tap the End On 
pick list and tap Choose Date. Use the date picker to select an end date.

8. Tap OK. An icon that represents a repeating event appears to the far 
right on the event line.

Making changes to repeating or continuous events

When changes are made to a repeating or continuous event you have the 
option of applying the change to just the current event, the current event 
and all future occurrences of this event, or all occurrences of this event - 
past, present, and future.

To delete repeating events:

1. Select the event you want to delete.

2. Tap Details. The Event Details screen opens.

Tap the 
Repeat 
box.
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3. Tap Delete. The Repeating Event screen opens asking for confirmation 
of the delete.

TIP: You can also select Delete Event from the Record menu. This 
opens the Repeating Event screen.

4. Select one of the following options:

• Current deletes a single occurrence of this event

• Future deletes the current event and all future occurrences of this 
event

• All deletes all past, current, and future occurrences of this event.

The event is removed from your datebook and you are returned to the day 
view where you started. These steps apply to all changes you make to 
repeating or continuous events.

About scheduling repeating or continuous events

Keep the following in mind when scheduling repeating or continuous 
events:

• If you change the start date of a repeating event, your electronic 
notebook calculates the number of days you moved the event. Your 
electronic notebook then automatically changes the end date to 
maintain the duration of the repeating event.

• If you change the repeat interval (e.g., daily to weekly) of a 
repeating event, past occurrences (prior to the day on which you 
change the setting) are not changed, and your electronic notebook 
creates a new repeating event.

Tap 
Delete
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• If you change the date of an occurrence of a repeating event (e.g., 
from January 14 to January 15) and apply the change to all 
occurrences, the new date becomes the start date of the repeating 
event. Your electronic notebook adjusts the end date to maintain the 
duration of the event.

• If you change other repeat settings (for example, time, alarm, 
private) of a repeating event and apply the change to all 
occurrences, your electronic notebook creates a new event. The start 
date of this new event is the day on which the setting is changed. 
Past occurrences (prior to the day of the change) are not changed.

• If you apply a change to a single occurrence of a repeating event 
(e.g., time), that occurrence no longer shows the Repeat icon.

Rescheduling events

You reschedule events using the Details option in the Date Book. You can 
also use the Details option to convert untimed events into timed events. 

To reschedule an event:

1. Tap the event you want to reschedule.

2. Tap Details.

3. To change the time, tap the Time box, select a new time, and then tap 
OK. 

4. To change the date, tap the Date box, select a new date, and then tap OK.

Adding Address Book information to an event
You can add a name, address, and telephone number to an event using the 
Phone Lookup option. For instructions, see "Using Phone Lookup" on page 
136.

Setting the alarm
The Alarm setting lets you set an audible alarm for events in your Date 
Book, and display a reminder message on-screen. For untimed events, only 
the reminder message appears.
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Setting an alarm for an event

You can set an alarm for minutes, hours, or days before an event. When 
you set an alarm, an Alarm icon appears to the far right of the event with 
the alarm. 

You can also set a silent alarm for untimed events that displays a reminder 
message on-screen before the day of the event. The alarm triggers at the 
specified period of minutes, hours, or days before midnight of the day on 
which the untimed event begins. 

For example, you set a 5-minute alarm for an untimed event that occurs on 
February 4. The reminder message will appear at 11:55 p.m. on the night of 
February 3. The reminder remains onscreen until you turn on your 
electronic notebook and tap OK to turn off the reminder.

To set an alarm for an event:

1. Tap the event to which you want to assign an alarm.

2. Tap Details.

3. Tap the Alarm check box to select it.

4. The default setting, 5 Minutes, appears.

5. Set the alarm time:

• Select the 5 next to the Alarm check box and enter any number from 
0 to 99 (inclusive) as the number of time units.

• Tap the pick list to change the time unit; select Minutes, Hours, or 
Days.

6. Tap OK.

Once an alarm has gone off, you can tap the Snooze option to dismiss the 
alarm for a 5-minute period. 

Tap here to 
select unit of time.

Enter number of 
time units here.
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To dismiss the alarm using the snooze option:

When the alarm dialog box appears, tap Snooze to delay the alarm for a 
preset five-minute period. 

Each time you tap Snooze, the alarm is dismissed for an additional 5-
minute period. 

Setting alarm options

You can set the alarm to go off automatically for each new event using 
preferences. You can also set a tone for the alarm and the number of times 
the alarm sounds. 

To set alarm options:

1. In the Date Book, press the menu key.

2. In the Options menu; tap Preferences.

3. Select from the following options: 

• Tap Alarm Preset to set an alarm for each new event automatically. 
The silent alarm for untimed events is defined by minutes, days, or 
hours before midnight of the date of the event. 
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• Tap the Alarm Sound pick list, and then tap an option to set the tone 
of the alarm. Options include Alarm, Alert, Bird, Concert, Phone, 
Sci-fi, and Wake Up.

• Tap Remind Me to define how many times the alarm sounds—once 
or twice; or three, five, or ten times.

• Tap Play Every to set how often the alarm sounds—every minute; 
or every 5, 10, or 30 minutes.

4. Tap OK.

Changing the Date Book view
The Date Book includes four views for displaying your appointments: day 
view, week view, month view, and agenda view. 

To display the Date Book views: 

1. Do one of the following:

• Press the date key repeatedly to cycle through all the Date Book 
views. 

• Tap a view icon in the lower-left area of the Date Book screen.

To display the current time:

Tap and hold down the stylus on the date in the date bar to display the 
time. (When you release the stylus, the menu bar appears.) 

Working in Week view

Week view displays a calendar of your events for an entire week. This view 
lets you quickly review your appointments and available time slots. In 
addition, the graphical display helps you spot overlaps and conflicts in 
your schedule.

To display the Week view:

1. Tap the Week view icon or press the date key until the Week view 
appears. 

Date Book view icons
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2. Tap the left and right navigation controls to move forward or backward a 
week at a time, or tap on a specific day to display the details of an event. 

NOTE: The Week View also shows untimed events and events before 
and after the range of times displayed.

3. Tap an event to display a description of the event at the top of the screen.

Tips for using Week view

Keep the following points in mind when using Week view: 

• To reschedule an event while in Week view, tap and drag the event 
to a different time or day.

Week view

Previous 
week

Next 
weekBar indicates earlier event.

Bar indicates later event. 

Dot indicates untimed event.

Event details

Tap to show event details.
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• Tap a blank time on any day to move to that day and have the time 
selected for a new event. 

• Tap any day or date that appears at the top of the Week view to 
move directly to that day without selecting an event.

• The Week view displays the time span defined by the Start Time 
and End Time in the Date Book Preferences settings. If you have an 
event before or after this time span, a bar appears at the top or 
bottom of that day's column. Use the onscreen scroll arrows to scroll 
to the event.

Spotting event conflicts

With the ability to define specific start and end times for any event, it is 
possible to schedule events that overlap (an event that starts before a 
previous event finishes).

An event conflict (time overlap) appears in the Week view as overlapping 
time bars and in the Day view as overlapping brackets to the left of the 
conflicting times.

Working in Month view

The Month View screen shows which days have events scheduled. Dots 
and lines in the Month view indicate events, repeating events, and 
untimed events.

Event 
conflicts
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You can control the dots and lines that appear in the Month View. See "To 
change the Date Book display of events:" on page 103 for more 
information.

Tips for using Month view

Keep the following points in mind when using the Month view: 

• Tap a day in the Month view to display that day in the Day view.

• Tap the scroll arrows in the upper right corner to move forward or 
backward a month. 

• Tap Go To to open the date selector and select a different month.

• Use the PgUp/PgDn keys to move between months. Press 
function-PgUp to display the previous month, or function-PgDn to 
display the next month. 

Working in Agenda view

The Agenda view lets you view appointments, untimed events, and To Do 
List items in a single screen. Although it is primarily a viewing option, you 
can also use the Agenda view to check off completed To Do List items. To 
go to a Day View of any event on the Agenda view screen, simply tap the 
desired event. 

To display the Agenda View:

1. Tap the Agenda view icon or press the date key until the Agenda view 
appears.

Previous/next month
Dots on right side indicate events.

Dashed line indicates continuous event.

Dots below date indicate untimed events.Month View button
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2. Use the navigation bars to move forward or backward a day at a time or 
to display more To Do items.

Tips for using Agenda view

• Tap any appointment while in Agenda view to display the Day 
View of the appointment. 

• Check off completed To Do List items in the Agenda view, or click a 
description of an item to go directly into the To Do List application. 

• You can change the category of To Do items shown. Tap on the pick 
list and select the new category. See "Using the To Do List" on page 
107, for more information on To Do items.

Changing the Date Book display
In Day or Month view, you can change which events appear in the Date 
Book. In Day view, you can display time bars that highlight event conflicts.

To change the Date Book display of events:

1. In Day view or Month view, press the menu key.

2. Tap Options, and then tap Display Options.

Agenda view

Scroll the list 
for each 
view
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3. For Day view, select from the following options:

• Tap Show Time Bars to display time bars showing the duration of 
an event and any event conflicts.

• Tap Compress Day View to display start and end times for each 
event, but no blank time slots at the bottom of the screen, to 
minimize scrolling. Clear the option to display all time slots. 

4. For Month view, select whether to display Timed, Untimed, or Daily 
Repeating events.

5. Tap OK.

Changing the displayed Start and End Times

You can change the preferences used for new entries. Preferences include 
display starting time, display ending time, and alarm characteristics. See 
the section "Setting alarm options" on page 98 for more information on 
alarm preferences.

To change the start and end time in the Date Book:

1. In the Date Book, press the menu key.

2. Tap Option, and then tap Preferences.
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The Start and End Time are used by the various Date Book screens. The 
Day view schedules events to start and end at these times when the All 
Day option is selected. The Week view displays the time span defined by 
the Start Time and End Time.

3. Tap Start Time and use the scroll arrows to select a new start time for the 
Date Book screens. Repeat the step to set a new end time. If the time 
slots you select do not fit on one screen, you can tap the scroll arrows to 
scroll up and down.

4. Tap OK.
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Using the To Do List
The To Do List is a convenient place to create reminders and prioritize the 
things that you have to do.

Use the To Do List to: 

• Make a quick and convenient list of things to do.

• Assign a priority level to each task.

• Assign a due date for any or all of your To Do List items. 

• Assign To Do List items to categories so that you can organize and 
view them in logical groups. For more information, see 
"Categorizing records" on page 131.

• Sort your To Do List items either by due date, priority level, or 
category.

• Attach notes to individual To Do List items for a description or 
clarification of the task. For more information, see"Attaching notes" 
on page 140.

To open the To Do List:

Press the to do key to open the To Do List to the category of items you last 
viewed.

NOTE: Press the to do key repeatedly to cycle through the categories 
in which you have items.

Creating To Do List items
A To Do List item is a reminder of some task that you have to complete. A 
record in the To Do List is called an item.

To create a To Do List item:

1. Press the to do key to display the To Do List.

2. Tap New.



108

3. Enter the text of the To Do List item. The text can be longer than one line.

TIP: You can add a name, address, and phone number to a To Do List 
item using the Phone Lookup option. For more information, see "Using 
Phone Lookup" on page 136.

4. Tap anywhere onscreen to deselect the To Do List item.

TIP: If no To Do List item is currently selected, typing on the keyboard 
automatically creates a new item.

Setting To Do List priorities

You can set priorities for tasks in your To Do List according to their 
importance or urgency. Items appear by priority and due date at the top of 
the To Do List by default, with 1 the highest priority. Changing an item’s 
priority may move its position in the list. 

New To Do List items automatically have a priority of 1. If you select 
another item first, before creating a new item, the item you create appears 
beneath the selected item with the same priority as the selected item. 

Tap New

New To 
Do item
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To set the priority of a To Do List item:

1. If priorities aren’t visible in the To Do List, tap Show at the bottom of 
the list, tap Show Priorities, and tap OK.

2. Tap the Priority number on the left side of the To Do List item.

3. Tap the Priority number that you want to set, with 1 the most important 
and 5 the least important. 

Checking off To Do List items

You can check off a To Do List item to indicate that you’ve completed it. 

To check off a To Do List item:

1. In the To Do List, tap Show. Tap Show Completed Items. If you clear this 
setting, your To Do items disappear from the list when you complete 
(check) them. 

NOTE: Items that no longer appear on the list because Show 
Completed Items is turned off have not been deleted. They are still in 
Dana’s memory. You must purge completed items to remove them from 
memory.

Tap to 
select 
priority.

Tap here
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2. Tap the check box on the left side of the item.

Changing priorities and due dates
You can change the To Do List to display the due date assigned to an item, 
change its priority, and assign a category to the task with the To Do Item 
Details dialog box. 

You can then sort To Do List items by priority, due date, or category.

To change the priority and due date of a To Do List item:

1. In the To Do List, tap the item that you want to change.

2. Tap Details.

3. In the Details dialog box, tap No Date to open the Due Date pick list.

4. Tap the date that you want to assign the item. Options are Today, 
Tomorrow, One Week from the current date, No Date to remove the due 
date from the item, or Choose Date to display the date selector and select 
a date.

5. Tap Private to hide this item when Security is turned on.

6. For more information, see "Making records private" on page 138.

7. Tap OK.

Completed 
To Do List 
item

Tap here.
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TIP: If you turn on the Show Due Dates option in the To Do 
Preferences dialog box, you can tap directly on the due date in the To 
Do List to open the pick list shown in step 3.

To sort To Do items:

1. In the To Do List, tap Show.

2. In the To Do Preferences screen, tap Sort By, and then select an option 
from the pick list:

3. Tap Priority, Due Date to sort items by priority first, and then due date. 
Tap Due Date, Priority to reverse that order.

4. Tap Category, Priority to sort items by category first, and then priority. 
Tap Priority, Category to reverse that order.

5. Tap OK.

Displaying completed and due items
You can have the To Do List display completed items and their completion 
dates, as well as due items and their due dates. 

To display completed and due items in the To Do List:

1. In the To Do List, tap Show.

2. In the To Do Preferences dialog box, choose from the following settings:

• Tap Show Completed Items to display your completed items in the 
To Do List. If this setting is turned off, completed To Do items 
disappear from the list, but are kept in Dana’s memory. You must 
purge completed items to remove them from memory.
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• Tap Show Only Due Items to show only the items that are currently 
due, past due, or have no due date specified. When this setting is 
active, items that are not yet due do not appear in the list until their 
due date.

• Tap Record Completion Date to replace the due date with the actual 
date when you complete (check) the item. If you do not assign a due 
date to an item, the completion date still records when you complete 
the item.

• Tap Show Due Dates to display the due dates for items in the To Do 
List and to display an exclamation mark next to items that remain 
incomplete after the due date passes.

3. Tap OK.
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Using the Address Book
The Address Book lets you keep names, addresses, telephone numbers, 
and other information about your personal or business contacts.

Use the Address Book to: 

• Quickly enter, look up, or duplicate names, addresses, phone 
numbers, and other information.

• Enter up to five phone numbers (home, work, fax, car, and so on) or 
e-mail addresses for each name.

• Define which phone number appears in the Address List for each 
Address Book entry. 

• Attach a note to each Address Book entry, in which you can enter 
additional information about the entry.

• Assign Address Book entries to categories so that you can organize 
and view them in logical groups.

To open the Address Book: 

Press the address key to open the Address Book and display the list of all 
your records.

NOTE: Press the address key repeatedly to cycle through the 
categories in which you have records.

Adding and using Address Book entries
The Address Book application stores name and address information about 
people or businesses.

Creating an Address Book entry

A record in Address Book is called an entry. You can create entries on Dana, 
or you can use Palm Desktop software to create entries on your computer 
and then download them to Dana during your next HotSync operation.

Palm Desktop software also has data import capabilities that let you load 
database files into the Address Book on Dana. 

See "Importing data" on page 51 and Palm Desktop online Help for more 
information.
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To create a new Address Book entry:

1. Press the address key to display the Address List.

2. Tap New.

3. Enter the last name of the person you want to add to your Address Book. 

4. Tap the First Name field to move to it. You can move to any field by 
tapping it directly.

5. Enter the individual’s first name in the First Name field.

6. If you want to be able to sort the Address Book by company name, enter 
the information you want in the Company field. 

7. Enter any other information that you want to include in the entry.

8. Tap the scroll arrows to move to the next page of information.

9. To attach a note to an entry, tap Note. Enter the information you want to 
add, and then tap Done.

10. When you have finished entering information, tap Done.

Tap New.

Cursor 
at Last 
name



Dana User’s Guide 115

TIP: To create an entry that always appears at the top of the Address 
List, begin the Last name or Company field with a symbol, as in *If 
Found Call.* This entry can contain contact information in case you lose 
your electronic notebook.

To view details of an address entry:

1. Tap the address entry in Address List view.

The entry appears in Address view.

2. Tap Done when you have finished viewing the entry.

Tap Done

Tap entry

Tap Done
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Duplicating an entry

You can duplicate existing entries, which can be helpful when you want to 
enter multiple people from a single organization. When you duplicate an 
entry, the word Copy appears next to the name in the First Name field. 

To duplicate an entry:

1. From the Address Book, tap a name you want to duplicate.

2. Tap Edit

3. Do one of the following:

• Tap the Address Edit tab at the top of the screen; then tap Duplicate 
Address in the Record menu. 

• Press cmd-T.

4. Edit the record as necessary. 

Selecting different types of phone numbers and addresses

You can select the types of phone numbers or e-mail addresses that an 
Address Book entry displays. Any changes you make apply only to the 
current entry. 

To select other types of phone numbers in an entry:

1. Tap the entry that you want to change in the Address list. 

2. Tap Edit.

3. Tap the pick list next to the label you want to change.

Tap 
arrow
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4. Select a new label.

Editing Address Book entries

You can change the type of information that appears in the Address List 
screen, categorize an entry, and hide an entry for security reasons. You can 
also delete entries. 

To edit an Address Book entry:

1. Tap the entry that you want to change in the Address list.

2. Tap Edit.

3. Tap Details.

4. In the Address Entry Details dialog box, select any of the following 
settings:

• Tap Show in List, and in the pick list tap which type of phone or 
other information you want to appear in the Address List screen. 
Options are Work, Home, Fax, Other, and E-mail. 

• Tap Category, and then tap a category in the pick list that you want 
to assign to the entry. 

• Tap Private to hide the entry when Security is turned on.

5. To attach a note to an entry, tap Note, enter information and tap OK.

6. To delete an entry, tap Delete.

7. Tap OK.

Tap 
new label
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Changing the Address Book display
You can change how Address Book lists are sorted and you can add custom 
fields for entering additional information, using preferences. You can also 
have the Address Book display the last category you selected each time 
you return to the application.

To change how lists are sorted:

1. In the Address list or in Address view, press the menu key.

2. Tap Options, and then tap Preferences.

3. Choose an option to sort Address Book lists from the List By pick list:

• Tap Last Name, First Name to sort alphabetically by an individual’s 
last name and then first name.

• Tap Company, Last Name to sort alphabetically by the company 
name, and then an individual’s last name.

4. Tap OK.

To add custom fields at the end of Address Edit screens:

1. In the Address list or in Address view, press the menu key.

2. Tap Options, and then tap Rename Custom Fields.
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3. Rename the fields to identify the information you’ll enter in them. The 
names you give the custom fields appear in all entries, at the end of the 
Address Edit screen. 

4. Tap OK in the Rename Custom Fields dialog box.

To control the Address Book display on returning to the application:

1. In the Address list or in Address view, press the menu key.

2. Tap Options, and then tap Preferences.

3. In the Address Book Preferences dialog box, select an option:

• To have the Address Book redisplay the last category you selected 
on returning to the application, tap the Remember Last Category 
check box to select it.

• To have the Address Book display the All category on returning to 
the application, tap the Remember Last Category check box to clear 
it.

• If you have a lot of entries in your address book, you might want to 
select the Enable Fast OneHand check box. With Fast OneHand 
enabled only the first letter of entries are shown in the list. Clicking 
on a letter will take you to the first entry under that letter.

4. Tap OK.



120



Dana User’s Guide 121

Using the Memo Pad
The Memo Pad provides a place to take notes that are not associated with 
records in the Date Book, Address Book, or To Do List.

Use the Memo Pad to: 

• Take notes or write any kind of message on your electronic 
notebook. 

• Assign memos to categories so that you can organize and view them 
in logical groups.

• Write down phone numbers and other types of information. Later, 
you can copy and paste this information into other applications. 

To open the Memo Pad:

Tap the Memo Pad icon in the Application Launcher. The Memo Pad opens 
to display the last Memo Pad screen that you viewed.

Creating memos
A record in the Memo Pad is called a memo. A memo can contain up to 
4,000 characters. The number of memos you can store is dependent only on 
Dana’s available memory.

When you create a new memo, you can add information to it from the 
Address Book application, such as a phone number or address, using the 
Phone Lookup option. See "Using Phone Lookup" on page 136.

To create a new memo:

1. Press the apps key.

2. Tap the Memo Pad icon to display the Memo List.

3. Tap New.
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TIP: You can also create a new memo by beginning to type on the 
keyboard while in the Memo List screen. The first letter is automatically 
capitalized and begins your new memo. 

4. Enter the text you want to appear in the memo. Use the enter key to move 
down to new lines in the memo.

5. Tap Done. 

You can categorize memos and sort them by categories. See "Categorizing 
records" on page 131 and "Sorting records" on page 137 for more 
information.

Reviewing memos
The Memo List displays the first line of a memo. This makes it easy to 
locate and review your memos. You can easily sort memos in the Memo 
List or move through memos using Memo options.

Tap New.
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To review a memo:

1. In the Memo List, tap the text of the memo.

2. Review or edit the text in the memo. 

3. Tap Done.

To move through a memo you’re reviewing:

1. In the Memo List, tap the text of the memo you want to review.

2. Press one of the following options to move toward the beginning or end 
of the memo:

• Press function-PgUp to move toward the top (first) line of the 
memo.

• Press function-PgDn to move toward the bottom (last) line of the 
memo.

To change the order in which memos appear in the Memo List:

1. In the Memo List, tap the menu key.

2. Tap Options.

3. Tap Preferences, and choose one of the following options:

• Tap Manual to sort new memos in the sequence in which you create 
them.

Tap a 
memo to 
review its 
contents
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• Tap Alphabetical to sort new and existing memos in numerical and 
then alphabetical sequence. 

4. Tap OK.
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Using the Calculator
The Calculator lets you perform general mathematical functions, such as 
addition, subtraction, multiplication, and division. 

Use the Calculator to: 

• Perform basic calculations.

• Store and retrieve values.

• Display the last series of calculations, which is useful for confirming 
a series of “chain” calculations.

To open the Calculator:

Press function-calc.

Using the Calculator buttons
The Calculator includes several buttons to help you perform calculations.

• The CE button clears the last number you entered. Use this 
button if you make a mistake while entering a number in the middle 
of a calculation. This button enables you to re-enter the number 
without starting the calculation over.

• The C button clears the entire calculation and enables you to 
begin a fresh calculation.

• The Plus/Minus button toggles the current number between 
a negative and positive value. If you want to enter a negative 
number, enter the number first and then press the +/- button.
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• The M+ button places the current number in memory. Each 
new number you enter with the M+ button is added to the total 
stored in memory. The number that you add can be either a 
calculated value or any number you enter by pressing the number 
buttons. Pressing this button has no effect on the current calculation 
(or series of calculations); it merely places the value into memory 
until it is recalled.

• The MR button recalls the stored value from memory and 
inserts it in the current calculation.

• The MC button clears any value that is stored in the 
Calculator memory.

Displaying recent calculations
The Recent Calculations command lets you review the last series of 
calculations and helps you confirm a chain of calculations.

To display recent calculations:

1. In the Calculator application, press the menu key.

2. Tap Options, and then tap Recent Calculations.

3. When you have finished reviewing the calculations, tap OK.
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6
Performing Common 
Tasks
The tasks described in this section use the term records to refer to an 
individual item in any of the basic applications, for example, a single Date 
Book event, Address Book entry, To Do List item, or Memo Pad memo.

Creating records
You can use the following procedure to create a new record in Date Book, 
Address Book, To Do List, and Memo Pad.

To create a record:

1. Select the application in which you want to create a record.

2. Tap New. (For the Date Book only, select start and end times for your 
appointment and tap OK.)

3. Enter text for the record.

4. As an option, tap Details to select attributes for the record.

5. In the Address Book and Memo Pad only, tap Done.

Dana saves the new record automatically.

Editing records
After you create a record, you can change, delete, or add new information 
at any time. When the screen is in edit mode, a blinking cursor appears 
within the information, and the information appears on a dotted gray line 
called an edit line.
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You can enter text in any of the ways described in "Entering Data" on page 
37.

Selecting Text
Select the text you want to edit using one of the following techniques:

• Double-tap on a word in a field to select the word.

• Triple-tap on any word on a line to select the entire line.

• Drag across a line of text to select some or all of the information, or 
drag down to select text across multiple lines.

Using the Edit menu
The Edit menu is available from any screen where you enter or edit text. As 
a general rule, the Edit menu commands affect selected text. You can 
display the Edit menu in 4 ways: by tapping the menu key, by tapping the 
inverted tab at the top of the screen, by pressing cmd-menu shortcut letter, 
or writing a Graffiti shortcut. 

To use the Edit menu: 

1. Do one of the following to display the Edit menu: 

• Tap the Menu icon; then tap the Edit menu to display the 
commands in the menu. 

• Tap the inverted tab at the top of the screen; then tap the Edit menu 
to display the commands in the menu. 

• Press cmd-menu shortcut letter. For example, press cmd-c for Edit 
Copy.

• Press cmd-tab, or drag a diagonal line from the lower left to upper 
right in the text area of the WritePad to display the Command 

Edit line Cursor
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toolbar. To select a command, either tap the icon representing a 
command on the Command toolbar, or draw the Graffiti shortcut in 
the WritePad.

2. Choose from the following commands, depending on the application 
you’re using: 

• Undo reverses the last action taken. 

• Cut removes a selection from its current location to memory. You 
can then paste the text into another area of the current application or 
into a different application.

• Copy copies a selection and moves it to memory. You can paste the 
selection into another area of the current application or into a 
different application.

• Paste inserts a selection from memory into an area you select. Paste 
produces no result if you have not used the Cut or Copy commands. 

• Select All selects all the text in the current record or screen. 

• Keyboard opens the onscreen keyboard. Tap Done to close the 
keyboard. 

• Graffiti Help opens the Graffiti character stroke screen.

Deleting records
You can delete records in any of the basic applications. 

To delete a record in any of the basic applications:

1. Select the record you want to affect.

2. Do one of the following: 

• Press the menu key, under the Record menu tap the Delete 
command. 
The Delete command differs depending on the application you’re 
using, for example, Delete Event appears in the Record menu while 
you’re in the Date Book, and Delete Item appears when you’re using 
the To Do List. 

• Tap the inverted tab at the top of the screen, open the Record menu, 
and then select the desired Delete command. 
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• In the Details dialog box of the application, tap Delete, and then tap 
OK.

• Delete the text of the record. 

NOTE: In the Date Book, deleting the text of a repeating event deletes 
all instances of the event. 

• Press cmd-tab, or drag a diagonal line from the lower left to upper 
right in the text area of the WritePad to display the Command 
toolbar. Then tap the Delete icon, or draw a Graffiti ’D’ in the text 
area.

A confirmation dialog box appears. 

3. To archive a copy of the deleted record on your computer, select the Save 
Archive option. If you choose the archive option, the record is 
transferred to the archive file on your computer the next time you 
perform a HotSync operation.

4. Tap OK to delete the record. 

Purging records
Over time, as you use Date Book, and To Do List you may accumulate 
records that are no longer useful. For example, events that occurred 
months ago remain in the Date Book, and completed To Do List items 
remain in the list.

Outdated records take up memory on your electronic notebook, so it’s a 
good idea to remove them by using Purge. If you think Date Book or To Do 
List records might prove useful later, you can purge them from your 
electronic notebook and save them in an archive file. 

Purging is not available in Address Book or Memo Pad; delete records 
from these applications manually. 

To purge records:

1. Open the application from which you want to purge records. 

2. Choose from the following options:

Delete icon
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• Press the menu key, open the Record menu, and then tap Purge. A 
confirmation dialog box appears.

• Tap the inverted tab at the top of the screen, open the Record menu, 
and select Purge. 

3. Choose from the following options:

• For the Date Book, select the Delete Events Older Than pick list and 
select an option—1 week, 2 weeks, 3 weeks or 1 month.

• For the Date Book or To Do list, select Save Archive Copy on PC to 
save a copy of purged records in an archive file on your desktop. 
Selecting this option transfers purged records to an archive file the 
next time you perform a HotSync operation. Tap OK.

Categorizing records
You can categorize records in the Address Book, To Do List, and Memo Pad 
for easy retrieval. (The Date Book does not have categories.) When you 
create a record, it is automatically assigned to the currently displayed 
category. For example, if the All category is displayed, the record is 
assigned to the Unfiled category. A record can remain unfiled or it can be 
assigned to a category at any time. 

You can create, rename or delete categories. Each application can have up 
to 15 categories.

To move a record into a category:

1. Select the record you want to categorize.

2. Tap Details. (From the Address View screen, tap Edit first.)

3. In the Details dialog box, tap the Category pick list, select the desired 
category, and then tap OK. 

To display a category of records:

1. Open one of the following applications: the Address Book, the To Do 
List, or the Memo Pad. 

2. Tap the pick list in the upper right corner of the screen; then tap the 
category you want to display. 
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TIP: Pressing the address, to do, or memo key on Dana toggles 
through the categories assigned to the application, respectively. 

To add or edit application categories:

1. In the Address Book, To Do List, or Memo Pad, choose from the 
following options:

• Tap the pick list in the upper right corner of the screen, and tap Edit 
Categories. 

Tap pick list

Select a category

Edit Categories
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• In the Address Book, select a record and tap Edit; then tap Details. 
In the Category pick list, tap Edit Categories.

• In the Memo Pad and To Do List, select a record from the list, and 
tap Details. In the Category pick list, tap Edit Categories.

2. Select any of the following options:

• To create a new category, tap New, enter a new name, and Tap OK. 

• To rename a category, tap it in the list to select it. Tap Rename, enter 
a new name, and Tap OK.

• To delete a category, tap it in the list to select it. Tap Delete.

3. Tap OK.

To rename a category:

1. Tap the pick list in the upper right corner of the screen; then tap Edit 
Categories. 

2. Select the category you want to rename; then tap Rename.

3. Enter the new name for the category, and tap OK.

4. Tap OK to exit the Edit Categories dialog box. 

TIP: You can move records from multiple categories into a single 
category by renaming all discrete categories with a single category 
name. 

Tap for new category
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Printing records
In addition to printing AlphaWord files you can also print records from the 
Address Book, To Do List, Memo Pad, and appointments from the Date 
Book. Printing files from many third-party applications is also supported 
including: spreadsheets, presentations, databases, and e-mail. For more 
information on supported applications and printers see the online manual 
- PrintBoyManual.pdf located in the PrintBoy folder under the Extras 
folder on the Palm Desktop for Dana software CD-ROM.

To Print a record:

1. If you haven’t already done so, complete the steps for "Printing Setup" 
on page 72.

2. Press the apps key repeatedly till you see ALL in the top right corner of 
the Applications Launcher.

3. Tap the Print icon.

4. Select the type of record you want to print.

5. If you are printing via USB, connect one end of the USB cable to the 
Dana printer port and connect the other end of the cable to the printer. If 
you are printing via infrared (IrDA), point Dana’s IrDA port at the 
Printer’s IrDA port. 

6. Select a record and then tap the Print button.

To Print a record via the Send menu:

You can print records directly from the Address Book, To Do List, Memo 
Pad, and the Date Book by using the Send menu.

1. Open the application you want to print from (i.e. Date Book).

2. Select the record you want to print.

3. Press the menu key.

Tap to select a record 
type
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4. Under the Record menu, tap the appropriate Send command.

5. Tap OK to print.

Finding records 
Your electronic notebook lets you find information in several ways: 

• In all applications, starting with the current application, you can 
locate selected text.

• In the Date Book, the To Do List, and the Memo Pad, you can use 
Phone Lookup to display the Address List screen and add the 
information from this list to a record.

• In the Address Book, you can use the Look Up option to enter the 
first letters of a name to scroll immediately to that name.

Finding Address Book records
You can look up Address Book records pressing function-PgUp or 
function-PgDn or by typing the first few letters of a name in the Look Up 
option at the bottom of the address screen. 

To look up an Address Book record: 

1. Do one of the following:

• From the Address screen, enter the first few letters of the name you 
want to locate. 

• Pressing function-PgUp or function-PgDn to scroll a screen at a 
time or the up or down arrow keys (PgUp or PgDn) to scroll a 
record at a time. 

Look Up option
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Using the Find option
The Find option lets you locate text in any or all applications. For example, 
if the text “dog” appears in the Address Book and the Date Book, the Find 
option displays both occurrences in the Find dialog box. 

To use the Find option:

1. Press the find key.

2. Enter the text you want to find; then tap OK. 

Note that the Find option is not case sensitive; searching for "davidson" 
also finds "Davidson." 

TIP: Select text in an application before tapping Find to automatically 
place the text in the Find dialog box. 

Find searches for the text in all records and all notes within all applications. 

As Dana searches for the text, you can tap Stop to stop the search at any 
time. To continue the search after tapping Stop, tap Find More.

NOTE: Find will locate all matches that begin with the supplied text. It 
will not find words where the supplied text appears in the middle or at the 
end of a word.

Using Phone Lookup 
The Phone Lookup option lets you add a telephone number from the 
Address Book to an entry in another application. For example, you can add 
your dentist’s telephone number to your dental appointment date in the 
Date Book. 
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To use Phone Lookup:

1. Display the record in which you want to insert a phone number. The 
record can be in the Date Book, the To Do List, or the Memo Pad.

2. Do one of the following: 

• Press the menu key. Tap Options, and then tap Phone Lookup. 

• Tap the inverted tab at the top of the screen; then tap Options and 
tap Phone Lookup. 

• Press cmd-L. 

3. Select a record or write the first few letters of the name you want to add. 
Tap Add to add the information to the record.

NOTE: You can also search based on selected text. Drag to highlight 
the text, then follow step 2 above. When the search is complete, the 
name and phone number of the candidate will replace the selected text.

Sorting records
You can sort lists of records in various ways, depending on the application. 
Sorting is available in applications that display lists—in the Address Book, 
To Do List, and Memo Pad.

To sort records in the To Do List application:

1. Open the To Do List application to display the list screen.

2. Tap Show.

3. Tap the Sort By pick list, and select an option.

4. Tap OK.

Select a Sort By option
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To sort records in the Address Book and Memo Pad:

1. Open the application to display the list screen.

2. Do one of the following:

• Press the menu key. From the Options menu, tap Preferences. 

• Tap the inverted tab at the top of the screen; then tap Preferences in 
the Options menu. 

• Press cmd-R.

3. In the Preferences dialog box, tap the option you want; then tap OK to 
sort the list.

To sort the Memo List manually:

Tap and drag a memo to a new location in the list. 

TIP: To display the list of your memos on your computer as you 
arranged them manually on your electronic notebook, open Memo Pad 
in Palm Desktop software click List By, and select Order on Handheld.

Making records private
A Security application is available to users who have the Dana 
Productivity Pack that lets you make individual records private in all the 
basic applications . Private records can be either masked or hidden. Private 
records remain visible and accessible until you select a security setting to 
Hide records. Private record names are covered with a gray bar when the 
security setting is set to Mask records.

If you have assigned a password to your device, you must enter it before 
private records are displayed. See "Assigning security options" on page 60 
for more information.

Select a Sort By option
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To make a record private:

1. In your application, do one of the following:

• Create a new record and tap Edit, and then tap Details.

• Select an existing record, and tap Details.

2. Tap the Private check box. Tap OK.

3. At the alert in the Private Records dialog box, tap OK.

To hide private records:

1. Do one of the following:

• Press the apps key repeatedly till you see ALL in the top right 
corner of the Applications Launcher; then tap Security.

• From within an application, tap the inverted tab at the top of the 
screen; then tap Security in the Options menu. 

• From within any application, bring up the Command Bar and tap 
the padlock icon. To bring up the Command Bar, press cmd-tab.

2. In the Change Security dialog box, in the Current Privacy pick list, tap 
Hide Records; then tap OK.

To display private records:

1. Do one of the following:
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• Press the apps key repeatedly till you see ALL in the top right 
corner of the Applications Launcher; then tap Security.

• From within an application, tap the inverted tab at the top of the 
screen; then tap Security in the Options menu. 

• From within any application, bring up the Command Bar and tap 
the padlock icon. To bring up the Command Bar, press cmd-tab.

2. From the Current Privacy pick list, tap Show Records; then tap OK.

3. If you have assigned a password, you must enter the password before 
the hidden records are displayed. 

4. Enter your password, and then tap Show.

Attaching notes
You can attach notes to records in all the basic applications except the 
Memo Pad. A note can be up to several thousand characters long. 

To attach a note to a record:

1. Display the entry to which you want to add a note. 

2. In Address Book only, tap Edit.

3. Tap Details. 

4. Tap Note; then enter the desired note. 

5. Tap Done.

A note icon appears to the right of any item containing a note. 

To review or edit a note:

Tap the note icon.

To delete a note:

1. Tap the note icon.

2. Tap Delete; then tap Yes to delete the note. 

Note icon
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Choosing fonts
You can change the font in Memo Pad, Address Book, Date Book, and To 
Do List to improve appearance and readability. You can choose a different 
font for each application.

To change the font style:

1. Open an application.

2. Do one of the following: 

• Press the menu key. From the Options menu, tap Font.

• Tap the inverted tab at the top of the screen; then tap Font in the 
Options menu. 

3. Tap the font you want; then tap Select.

TIP: You can download additional FontBucket™ fonts to use on Dana 
at www.handshigh.com.

Getting information on an application
You can get information on any application by displaying its About box. 
The About box displays the name and version number of the application. 

To display the About box:

1. Press the menu key. 

2. In the Options menu, tap About. 

3. The text following the About command differs based on your location. 
For example, in the Date Book, the command is About Date Book. 

Displays how font will look

B stands for a Bold font.

Tap to select a font
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7
Using the Attention 
Manager
Some applications (such as Date Book) want to get your attention with 
some sort of alarm. Attention Manager allows you to conveniently manage 
all of these notifications in one place. Appointments and messages can 
stack up while you are away from your electronic notebook. Attention 
Manager lets you view them from a single list, where you can selectively 
dismiss or follow up on each event.

Applications will signal for your attention at two different levels: insistent 
and subtle. Each will be discussed in detail below.

Insistent alarms
Insistent applications open a Reminders dialog screen, and may play a 
sound, Alarms continue until you snooze or dismiss them. If the sound can 
be interrupted, you can tap anywhere on the screen, or push any key to 
silence it. Attention Manager will always open immediately when new 
insistent alarms are posted.
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Using the Reminder dialog screen

The Reminder dialog screen has three buttons for responding to an alarm:

OK: Makes the reminder go away, with no further notification.

Snooze: Switches to the application that was running when the alarm went 
off, and returns to the Reminder dialog screen after five minutes. You can 
go back to the Reminder dialog screen right away by tapping on the 
blinking indicator in the upper left corner of the screen. For more 
information, see “Understanding the blinking alarm indicator” below. 

Go To: Switches to the application that created the alarm, and shows the 
record that caused the alarm, although you may have to navigate within 
the application. There is no further notification.

Setting alarm volume

You control most alarm volumes globally in the General panel of the Prefs 
menu:

• From the Applications Launcher, tap the Prefs icon.

• Tap the General pick list in the upper right corner of the screen.

• Set the volume using the Alarm Sound pick list. 

Setting alarm sound effects

Some applications allow you to set the song or sound effect to use, and 
how many times to play it, with a pause in between. For example, to set 
alarm preferences for the Date Book, do the following:

1. While displaying the Date Book application, tap the Menu icon.

2. Tap the Options menu, and select Preferences.
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3. Tap the Alarm Preset check box, if you want alarms to sound, then 
select the following from the pick lists:

• How soon you want the alarm to sound before the event

• The alarm song or sound effect (for example, Bird or Concerto)

• How many times the alarm repeats before giving up

• The pause between each time the alarm sounds

Using the Reminders list screen

The Reminders dialog screen changes to a list of items that require your 
attention under two insistent alarm conditions:

• When a second application attempts to get your attention and the 
first has not been dismissed or snoozed.

• When a first application makes a second attempt and the first has 
not been dismissed or snoozed.

Each listed reminder contains the date and time of the event. Depending 
on the application displaying the reminder, you may see an icon 
representing the application, and up to two lines of text. 
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Tapping on the text or icon will “Go To” that item and delete the event 
from the Reminders list screen.

Tapping in the check box will clear that item, similar to a To Do list item. 
The Attention Manager will draw a line through the text lines, pause for a 
moment, and them remove the item from the list, although the original 
data remains in the application.

The Reminders list screen displays three buttons that are used to respond 
to all of the items in the list:

Snooze: Puts the Reminders list screen to sleep for five minutes. After this 
time interval, the Reminders list screen is displayed again. You can go 
directly to the Reminders list screen without waiting, by tapping on the 
blinking alarm indicator. For more detail, see “Understanding the blinking 
alarm indicator” below.

Done: If the Reminders list appeared because of more than one insistent 
alarm, tapping Done closes the Reminders list screen, although the events 
will remain in the application that created them. The Reminders list screen 
will not appear again, unless you tap the blinking alarm indicator in the 
menu bar.

If the Reminders list appeared after you tapped the Snooze button, then 
tapped the blinking alarm indicator, then tapped the Done button, the 
reminder will continue to snooze.

For more detail, see “Understanding the blinking alarm indicator” below.

Clear All: removes all of the items from the list, but does not close the 
Reminders screen. Tap this button to erase a list of events that have passed 

Subtle alarms
Some applications provide a visual, and optionally audible indication, but 
do not otherwise disrupt your work flow. Subtle alarms do not display a 
Reminders screen. Instead, a blinking indicator will flash in the upper left 
corner of the title bar (of applications that allow it) when an alarm is 
present. 

Understanding the blinking alarm indicator

A blinking alarm indicator appears in the upper left corner of the 
application in the menu bar (of applications that allow it) under the 
following conditions:
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• While viewing a Reminders dialog screen, you tap the Done or the 
Snooze button

• A subtle alarm is present

The indicator appears in three different states:

• Off: The indicator is not shown at all when the list is empty.

• Blinking, two states: When the list is not empty but there are no 
new items, then the “star” indicator will blink on and off until the 
list has been emptied.

• Blinking, three states: When a new subtle alarm is received, the star 
will alternate flashing solid, exploded, then off, until you view the 
new event.

Tapping on the indicator opens the Attention Manager in list mode, even if 
there is only one item.
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8
Using an Expansion 
Card
Dana has 2 card slots that accepts Secure Digital (SD) or MultiMedia Card 
(MMC) expansion cards. These enable you to add additional software 
applications, memory, or hardware. You can also use an expansion card to 
back up data when it is inconvenient to perform a HotSync operation.

Inserting an expansion card
1. Hold Dana securely.

2. Insert the card into the expansion card slot, following the direction 
indicated by the expansion card icon on the top of Dana.

3. Use your thumb to push the card into the expansion slot. When you feel 
the card lock and hear the system sound, the card is properly seated 
within the slot
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Removing an expansion card
1. Hold Dana securely.

2. Use your thumb to lightly push against the top of the card, following the 
direction indicated by the expansion card icon on the top of Dana. The 
expansion card slot releases the card, and Dana plays the system sound.

3. Remove the card from the expansion card slot.

Opening expansion card applications
When an expansion card is properly seated in an expansion card slot, the 
Applications Launcher switches to the card and displays its contents. The 
pick list in the upper-right corner of the Launcher screen displays the name 
of the card. 

To open an application on an expansion card:

1. Press the apps key.

2. Tap the pick list in the upper right corner of the Launcher screen.

3. Tap the card name (in this case 16MB Expansion) on the pick list. The 
expansion card applications are displayed in the Applications Launcher. 
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4. Tap the application that you want to launch.

The selected application is loaded into memory and launched. If the 
application is already resident in main memory, it is not copied again, just 
launched.

Displaying expansion card application information
To display information about an application on an expansion card:

1. Press apps key.

2. Tap the pick list in the upper right corner of the Launcher screen.

3. Tap the card name on the pick list. The expansion card applications are 
displayed in the Applications Launcher.

4. Press the menu key to bring up the App menu.

5. Tap Info.

6. In the Device pick list, tap the card name. The size of the applications on 
the card are displayed

7. To display the application version, tap version.
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TIP: When you tap More, you access the CardInfo application, 
described in the Using CardInfo section.

Copying an expansion card application to Dana
To copy an application on your expansion card to Dana:

1. Press apps key.

2. Tap the pick list in the upper right corner of the Launcher screen.

3. Tap the card name on the pick list. The expansion card applications are 
displayed in the Applications Launcher.

4. Press the menu key to bring up the App menu

5. Tap Copy.

6. Select the source and the destination using the From and the Copy To 
pick lists.

7. Select the application and then tap Copy.

The application is copied to the selected destination.
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TIP: Some applications and databases are copy-protected and cannot 
be copied. These are listed with a lock icon next to them.

Deleting Applications from an expansion card

To delete an application from an expansion card:

1. Press apps key.

2. Tap the pick list in the upper right corner of the Launcher screen.

3. Tap the card name on the pick list. The expansion card applications are 
displayed in the Applications Launcher.

4. Press the menu key to bring up the App menu.

5. Tap delete.

6. Select the card name from the Delete From pick list.

7. Highlight the application you want to delete, then tap Done.

The application is deleted. Applications that are loaded in ROM (for 
example, Memo Pad) cannot be deleted, and are not listed.

Using CardInfo
Card Info lets you review general information about an inserted card and 
its contents, rename a card, and format a card. 

To use CardInfo:

1. Press the apps key repeatedly till you see ALL in the top right corner of 
the Applications Launcher.
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2. Tap the CardInfo icon .

3. To rename the expansion card, tap on the Card Info tab in the upper left 
corner of the application screen.

4. Select Rename Card, and enter the new name in the Rename Card dialog 
box.

5. Tap the Rename button.

6. To reformat the expansion card, tap Card Info, select Format Card, and 
tap OK in the Format Card dialog box.

WARNING! Reformatting the expansion card will destroy its data.

7. To display help for Card Info, tap Card Info in the upper left corner of 
the application screen.
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8. Select Help from the menu, and scroll through the tips that are 
displayed.

Using CardPro
While you can copy an application to an expansion card from the 
Applications Launcher, CardPro lets you lets you copy all types of files 
(including applications, databases, and data files). CardPro is available to 
users who have the Dana Productivity Pack. CardPro also lets you select 
and copy multiple files at the same time, and create folders on your 
expansion card to better organize your files.

WARNING! CardPro is for advanced users only. Do not use this utility 
if you are unfamiliar with files and folders. 

Launching CardPro:

1. Press the apps key repeatedly till you see ALL in the top right corner of 
the Applications Launcher.

2. Tap the CardPro icon 

After CardPro is launched, the main RAM view displays. This view 
displays all files (applications and databases) currently in RAM. The list of 
files can be sorted by name, date, size, creator, or type. 

Switch to SD view to display all the applications and databases currently 
stored on the SD memory card.

Tap here to switch to SD 
card view

Tap here to display 
different file types Tap here to display other 

file information
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Copying or moving files:

1. Tap the file you want to copy or move. To copy or move additional files 
at the same time, just tap them so they are also selected. To copy all files, 
choose Select All under the Edit menu.

2. Tap the Copy or Move button

NOTE: The Move command deletes the original files after they have 
been moved to the new destination.

3. Select the destination where you want the file to go and tap OK. If you 
want to create a new folder to put the file in, tap the New button.

TIP: If you want to change the name of the file you are copying, use 
Copy as under the File menu.

Renaming a file:

1. Tap on the view pick list and select the SD card view

2. Tap the file you want to rename.

3. Press the menu key.

4. Under the File menu, tap Rename.

5. Type in the new file name and tap OK.

Deleting a file:

1. Tap the file you want to delete.

Tap a folder to select a 
destination for the file

Tap here to create a new 
folder
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2. Tap the Delete button and then tap OK

WARNING! Only delete files you are familiar with to avoid deleting 
databases associated with the built-in apps, such as the Address Book, 
Memo Pad, To Do List, or Date Book.

Creating a folder:

1. Tap on the view pick list and select the SD card view.

2. Press the menu key.

3. Under the File menu, tap Make Folder.

4. Enter the folder name and tap OK.

Renaming a folder:

1. Tap on the view pick list and select the SD card view.

2. Tap the folder you want to rename.

3. Press the menu key.

4. Under the File menu, tap Rename Folder.

5. Type in the new name for the folder and tap OK.

Deleting a folder:

1. Tap on the view pick list and select the SD card view.

2. Tap the folder you want to delete.

3. Press the menu key.

4. Under the File menu, tap Delete Folder and then tap OK.

WARNING! Deleting a folder will also delete files stored in that folder.
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Setting Preferences:

1. Press the menu key.

2. Under the Options menu, tap Preferences.

3. Uncheck Hide system files if you want to see all the files on Dana.

TIP: Unless you have a specific need to see all files, we recommend 
you keep Hide system file checked. This prevents system files from 
being accidentally deleted or renamed.

4. Check Confirm overwrites if you want to be warned every time a file is 
about to overwrite another file of the same name.

5. Tap the sort order pick list to sort by Name, Size, Date, Creator, or Type.

6. Tap OK.

Tap here to change the 
sort order
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9
Setting Preferences
The Preferences screens enable you to customize the configuration options 
on your electronic notebook, including the following:

General Set the current date and time, the auto shut-off interval, the Beam 
Receive feature, and the system, alarm, and game sounds.

Date and Time Set the date, time, time zone, and Daylight Saving switch.

Formats Set the country default and the formats for dates, times, calendar, 
and numbers.

Connection Configure USB cable, modem, and infrared communication 
settings.

Owner Assign your name, phone number, and other owner information to 
Dana.

Keys Assign different applications to specific keys on Dana, and reassign 
the full-screen pen stroke command.

ShortCuts Define a list of Graffiti ® abbreviations.

Digitizer Calibrate the screen on Dana.

Network Configure Dana for use with a network.

Viewing preferences
To open the Preferences screens:

1. Press the apps key repeatedly till you see ALL in the top right corner of 
the Applications Launcher.

2. Tap the Prefs icon.

3. Tap the pick list in the upper-right corner of the screen.

4. Select the Preferences screen you want to view.



160 Sett ing Preferences

Keys preferences
The Keys Preferences screen let you assign different applications to 
application and utility keys (on the top right row of keys). For example, if 
you find that you seldom use To Do List and often use Memo Pad, you can 
assign the to do key to launch Memo Pad.

If you assign a different application to a key, you can still select the original 
application using the Applications Launcher. Changes made in the Keys 
Preferences screen take effect immediately.

You can also change the assignment of the full-screen pen stroke. By 
default, the full-screen pen stroke activates Graffiti help.

You can also assign applications to the file keys (F1-F8). For instructions, 
see "App Shortcuts" on page 168.

To change the Keys preferences:

1. Tap the pick list next to the key you want to re-assign.

2. Tap the application that you want to assign to the key.

TIP: To restore all of the buttons to their factory settings, tap Default.

Tap arrow to 
show pick list
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Pen Preferences
The Keys Preferences screen also enables you to change the assignment of 
the full-screen pen stroke. By default, the full-screen pen stroke activates 
Graffiti Help.

To change what the full-screen pen stroke activates:

1. In the Keys Preferences screen, tap Pen.

2. Tap the pick list, and tap one of the following settings for the full-screen 
pen stroke:

• Backlight turns on the backlight of your electronic notebook.

• Keyboard opens the onscreen keyboard for entering text characters.

• Graffiti Help opens a series of screens that show the complete 
Graffiti character set.

• Turn Off & Lock turns off and locks Dana. You must assign a 
password to lock Dana. When locked, you need to enter the 
password to use Dana. This feature is available to users who have 
the Security application that comes with the Dana Productivity 
Pack.

• Beam Data beams the current record to another Dana or Palm OS 
handheld.

3. Tap OK.

Drag to top 
of screen for 
full-screen 
pen stroke
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Digitizer preferences
The Digitizer Preferences screen opens the digitizer calibration screen. This 
is the same screen that appears when you start Dana for the first time.

You can recalibrate your screen after a hard reset, or if your stylus seems to 
be “off target”.

Formats preferences
Use the Formats Preferences screen to set the country default and the 
display format of the dates, times, and numbers on Dana.

Country default

When selecting a country and time, date, and number formats, keep the 
following in mind: 

• When you select a country, the time, date, and number formats are 
adjusted, as well as the week’s starting day. For example, in 
Germany, time often is expressed using a 24-hour clock and the 
starting day of the week is Monday; in the United States, however, 
time is expressed using a 12-hour clock with an AM or PM suffix 
and the starting day of the week is Sunday. You can customize your 
own settings.

• The Time setting defines the format for the time of day, which 
appears in all applications on your electronic notebook. 

To choose a country default: 

1. Tap the country name pick list.

2. Tap the setting you want to use.
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Time, date, week start, and numbers formats

The Time setting defines the format for the time of day. The time format 
that you select appears in all applications on Dana.

To select the time, date, week start, and numbers format:

1. Tap the Time pick list and select a format, where H is hour and M is 
minute.

2. Tap the Date pick list and select a format, where D is day, M is month, 
and Y is year.

3. Tap the Week starts pick list, and select whether you want the first day 
of the week to be Sunday or Monday. 

NOTE: This setting controls the Day, Week, Month, and Agenda views 
in Date Book and all other aspects of Dana that display a calendar.

4. Tap the Numbers pick list, and select formats for the decimal point and 
thousands separator.

General preferences
The General Preferences screen enables you to set the auto shutoff interval, 
alarm, system and game sounds, and the Beam Receive feature.

Setting the auto-off delay time
Your electronic notebook automatically turns off the power and backlight 
after a period of inactivity, to conserve battery power. If you find that your 
electronic notebook shuts itself off before you finish reviewing the 
information on the screen, you can increase the automatic shutoff setting.

To set the auto shutoff interval:

1. Tap the Auto-off pick list. 

2. Tap the setting you want to use for the automatic shutoff feature: 30 
seconds, 1 minute, 3 minutes, 5 minutes, 10 minutes, or 20 minutes.
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Setting the sounds and volumes
You can control the sound for system alerts, alarms, and games using the 
General Preferences screen.

To set the system, alarm, and game sounds:

1. To set sounds and volumes, tap the System, Alarm, or Game Sound pick 
list, and select the sound level—Off, Low, Medium, or High

Turning off the System Sound also turns off the chime tones used 
during HotSync operations. 

NOTE: The Game Sound setting typically works only with newer 
games that are programmed to respond to it.

Date and Time preferences
The Date and Time Preferences screen enables you to set the date, time, 
time zone, and Daylight Saving option on your electronic notebook.

See "Setting the date, time, and time zone" on page 28 for details.

Owner Preferences
Owner preferences let you record a name, company name, phone number, 
or any other information you want to include on your electronic notebook.

See "Setting owner preferences" on page 27 for details.

ShortCuts Preferences
The ShortCuts Preferences screen enables you to define abbreviations for 
entering text with Graffiti strokes. ShortCuts are similar to the Glossary or 
Autotext features of some word processors. 

See "Using Graffiti 2 ShortCuts" on page 48 for more information.
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Turning Beam Receive on and off
Beaming is discussed in Chapter 11. For information on using the Beam 
Receive preference, see "Turning off beaming" on page 177.

For information on configuring your electronic notebook to work with a 
modem or network, see "Setting Connection and Network Preferences" on 
page 193.
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10
Keyboard and Screen 
Options
The Screen application allows you to view the Dana screen vertically, 
rather than horizontally. Viewing the screen vertically can be more 
convenient for tasks like filling out forms, or reading an ebook. The 
Keyboard application allows you to customize the keyboard settings on 
Dana, including the following:

App Shortcuts Set which applications are launched when you press 
function-F1-F8. 

Key Repeat When checked, holding down a key will cause the character to 
repeat until the key is released. 

Power On Keys Set which keys (in addition to the on/off key) will turn 
Dana on and off. 

Keyboard Layout Change the keyboard layout to QWERTY (default), 
Dvorak, Left handed or Right handed. 

Special Needs: 

Sticky Keys Enables typing of combination keystrokes without having to 
press the keys simultaneously. 

Slow Keys Enables Users with motor impairment to adjust the amount of 
time that any key needs to be held down before it is sent to the application. 

General:

Keyboard Enable Allows keyboard input to Dana. 

Key Clicks Causes a clicking noise to occur every time a key is pressed on 
the keyboard. 
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Tab Movement Pressing the tab key will move the cursor to the next field 
instead of inserting a tab character, while shift-tab will move it to the 
previous field. 

Setting Keyboard options
To open the Keyboard application:

1. Press the apps key repeatedly till you see ALL in the top right corner of 
the Applications Launcher.

2. Tap the Keyboard icon.

3. Tap the pick list in the upper-right corner of the screen.

4. Select the Keyboard option you want to change.

App Shortcuts
Use App Shortcuts to customize which applications are launched when 
you press function-F1-F8. 

You can also assign different applications to application and utility keys 
(the top right row of keys). For instructions, see "Keys preferences" on page 
160.

To set the Application assigned to function-F1-F8:

1. Tap the arrow next to the function-file key you want to assign.

2. Tap the application that you want to assign to the key combination.

Tap arrow to show 
pick list
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Key Repeat
When Enable Key Repeat is checked, holding down a key will cause the 
character to repeat until the key is released. If Enable Key Repeat is 
unchecked, holding down a key will only generate one character.

Moving the slider under “Start repeat delay” adjusts the amount of delay 
before repeating the first key. Moving the slider under “Delay between 
repeats” adjusts the amount of delay that occurs after the first repeated key 
and all the following repeated keys.

To enable and adjust Key Repeat:

1. Check the box next to “Enable key repeat”. 

2. Drag the sliders right to increase or left to decrease the delay.

3. Use the Test Area to see how the key repeat process is affected

Power On Keys
The on/off key will always turn Dana on and off. The keys listed in the 
dialog can also be setup to turn on Dana. 

To set a Power On Key

1. Check the box next to the Power On Key you want to enable. 

Drag slider to 
change delay

Tap to enable/dis-
able key repeat

Tap checkbox to 
enable/disable a 
Power On Key
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TIP: If storing Dana in a backpack or briefcase, we recommend that 
the Power On Keys be disabled in order to minimize the risk that Dana 
will be turned on accidentally in transit.

Keyboard Layout
Dana gives you the option of four keyboard layouts: QWERTY is the 
standard default layout of most keyboards, Dvorak is scientifically 
designed to minimize finger stretching/reaching for the most commonly 
used keys, Left handed and Right handed layouts enable faster typing for 
people with disabilities. When a different layout is selected, the keyboard 
graphic will change to show the new layout and the keys will be 
reassigned. All the applications on Dana will use the new layout.

To change the keyboard layout:

1. Tap the arrow and choose a keyboard layout. 

2. Use the Test Area to try out the new keyboard layout.

Special Needs

Sticky Keys

With Sticky Keys enabled, you can type combination keystrokes without 
having to press the keys simultaneously. For example, you could press 
"function" and then press "calc" to launch calculator. Sticky Keys affects the 
four modifier keys: shift, option/alt/function, cmd, and ctrl. When Sticky 
Keys is enabled, pressing a modifier key effectively keeps that key "pressed 
down" for the next normal key press.

Tap arrow to show 
keyboard layouts
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Slow Keys

With Slow Keys enabled, Users with motor impairment can adjust the 
amount of time that any key needs to be held down before it is sent to the 
application. The greater the delay that is set in the slider, the more time is 
needed before Dana recognizes the key press.

To enable Sticky keys or Slow keys:

1. Check the box next to “Sticky Keys” or “Slow Keys”. 

2. For Slow Keys drag the slider right to increase or left to decrease the 
delay.

3. Use the Test Area to see try out various settings

General

Keyboard Enable

Enable keyboard input is checked by default to allow keyboard input to 
Dana. You may want to disable it if the screen is rotated, and you don't 
want to worry about accidentally pressing a key.

Key Clicks

Enabling key clicks will cause a clicking noise to occur every time a key is 
pressed on the keyboard. Even when this option is unchecked, some 
clicking will still occur for some operations. To disable all sound output, 
see "Setting the sounds and volumes" on page 164.

Tab Movement

Tab moves to the next field is checked by default, so pressing the tab key 
will move the cursor to the next field instead of inserting a tab character. 
Shift-tab will move the cursor to the previous field. If this is checked, then 

Drag slider to 
change delay

Tap to enable/dis-
able Sticky Keys 
or Slow Keys
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the only way a tab character can be entered is by using Graffiti. For more 
information see "Writing symbols and extended characters" on page 45.

To enable general keyboard setting:

1. Check the box next to the setting you want to enable. 

Screen Options
Dana can be set up using the screen application so that the screen is viewed 
vertically rather than horizontally. The screen can be rotated 90 degrees to 
the left or right. Viewing the screen vertically can be more convenient for 
tasks like filling out forms or reading an ebook.

You can also use the Screen application to turn off the display of the 
Billboard window (where the word “dana.” is displayed on the left side of 
the screen.) 

Rotating the screen:

1. Press the apps key repeatedly till you see ALL in the top right corner of 
the Applications Launcher.

2. Tap the Screen icon.

3. Tap an icon to change the screen orientation.

Tap to enable/dis-
able setting

Tap an icon to 
change the screen 
orientation
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4. Tap the OK button.

To turn off Billboard display:

1. Press the apps key repeatedly till you see ALL in the top right corner of 
the Applications Launcher.

2. Tap the Screen icon.

3. Press the menu key, and select Preferences from the View menu.

4. Tap to uncheck and turn off the Billboard display.

5. Tap OK.

Dana screen rotated 90 degrees 
to the left

Dana screen rotated 90 degrees 
to the right

Tap to uncheck
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11
Beaming Information
Dana is equipped with an IrDA (infrared) port that you can use to beam 
information to another to another Dana or IrDA-equipped Palm OS 
organizer. The IR port is located at the top of the electronic notebook, 
behind the small convex bump on the right side.

You can beam the following information between Danas:

• The record currently displayed in Date Book, Address Book, To Do 
List, or Memo Pad, or AlphaWord.

• All records of the category currently displayed in the Address Book, 
To Do List, or Memo Pad applications.

• A special Address Book record that you designate as your business 
card, containing information you want to exchange with business 
contacts.

• An application installed in RAM memory.

NOTE: AlphaWord or other printable files can also be beamed to an 
IrDA-capable printer. See "Printing Setup" on page 72 for more 
information.

For best results, the electronic notebooks should be between 10 centimeters 
(approximately 4 inches) and 1 meter (approximately 39 inches) apart, and 
the path between the two devices must be clear of obstacles. Beaming 
distance to other IrDA-equipped Palm OS organizers may be different.

Beaming a business card
To select a business card for beaming:

1. Press the address key.



176 Beaming Information

2. In the Address List, create a new entry or select an entry that contains the 
information you want on your business card.

3. In Address view, press the menu key. 

4. Under Record, tap Select Business card. At the prompt, tap Yes.

Beaming a record
To beam a record, business card, or category of records:

1. Locate the record, business card, or category you want to beam.

2. Press the menu key.

3. Tap Record.

4. Choose from the following options:

• Tap Beam to beam an individual item.

• In the Address Book application only, tap Beam Business Card.

• Press the address key for about two seconds to beam your business 
card.

• Tap Beam Category (for records that are displayed in a category).

• Press the send key or cmd-b to beam the current entry.

NOTE: You can set the full-screen pen stroke to beam the current 
entry. See "To change what the full-screen pen stroke activates:" on 
page 161 for more information. 

5. When the Beam Status dialog box appears, point the IR port directly at 
the IR port of the receiving electronic notebook.

Wait for the Beam Status dialog box to indicate the transfer is done.

Beaming an application
To beam an application:

1. Press the apps key.

2. Press the menu key.
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3. Tap App, and then tap Beam.

4. Tap the application you want to transfer, and tap Beam.

NOTE: Some applications are copy-protected and cannot be beamed, 
as indicated by a lock icon. 

5. When the Beam Status dialog box appears, point the IR port directly at 
the IR port of the receiving electronic notebook.

Wait for the Beam Status dialog box to indicate the transfer is done.

Receiving beamed information
To receive beamed information:

1. Turn on Dana.

2. Point the IR port directly at the IR port of the transmitting Dana to open 
the Beam Status dialog box.

3. Tap Yes.

4. Wait for the Beam Status dialog box to indicate that the transfer is 
complete, and then tap OK to display the new entry. 

5. Incoming records are placed in the Unfiled category.

Turning off beaming
To turn beaming on or off:

1. Press the apps key.

2. Select All or System from the pick list in the upper right corner of the 
screen.

3. Tap Prefs.

4. In the pick list in the upper right corner, tap General.

5. In the General Preferences screen, tap the Beam Receive pick list, and 
then tap On or Off to select the option.
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12
Exchanging and 
Updating Data using 
HotSync® Operations
HotSync® technology lets you synchronize—exchange and update—data 
between one or more Danas and Palm Desktop ™ Desktop  or another PIM 
such as Microsoft Outlook. 

The HotSync process automatically synchronizes data between your 
electronic notebook and Palm Desktop software. Changes you make on 
Dana or Palm Desktop software appear in both places after a HotSync 
operation. HotSync technology synchronizes only the needed portions of 
files, thus reducing synchronization time. 

You can synchronize your data by connecting Dana directly to your 
computer or indirectly with a modem or network. This chapter describes 
how to select HotSync options and perform a HotSync operation via USB 
cable, a modem, or network. 

Performing a HotSync operation for the first time
The first time you synchronize your data, you must enter user information 
on both Dana and Palm Desktop software. After you enter this information 
and synchronize, the HotSync Manager recognizes your Dana and doesn’t 
ask for this information again.

If you are preparing several electronic notebooks for a group of users, you 
may want to create a user profile. See "Creating a user profile" on page 181 
before performing the following steps.



180 Exchanging and Updating Data using HotSync®  Operations

Performing the first local HotSync operation
You must perform your first HotSync operation with a local, direct 
connection, rather than using a modem.

The following steps assume that you have already installed the Palm 
Desktop software. If you have not installed this software, see "Installing 
Palm Desktop software" on page 31 for instructions.

IMPORTANT: The version of Palm Desktop Software that comes with 
Dana must be installed before connecting Dana to a computer.

To perform a local HotSync operation:

1. Connect one end of the USB cable to the Dana computer port.

2. Connect the other end of the cable to a USB port on the computer.

3. The computer will automatically recognize the connection.

4. If the HotSync Manager is not running, start it: On the Windows 
desktop, click Start, and then choose Programs. Navigate to the Palm 
Desktop software program group and choose HotSync Manager. 
Alternatively, you can start the Palm Desktop software which 
automatically opens the HotSync Manager.

5. Press function-sync (press the function and sync keys simultaneously).

6. If you are performing the HotSync operation for the first time, you must 
enter a user name in the New User dialog box and click OK. The 
HotSync Progress dialog box appears and synchronization begins. 

Every electronic notebook should have a unique name. To prevent loss 
of a user’s records, never try to synchronize more than one electronic 
notebook to the same user name.
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7. Wait for a message on Dana indicating that the process is complete.

When HotSync is complete, you can unplug Dana from the USB cable.

NOTE: Trying to HotSync files to both expansion card slots during the 
same HotSync operation will cause an error.

Creating a user profile
You can create a user profile to load data into an electronic notebook 
without associating that data with a user name, using the File Link feature. 
This feature lets System Administrators configure several electronic 
notebooks with specific information (such as a company phone list) before 
distributing them to their actual users. For more information on the File 
Link option, see "Using File Link" on page 191.

The User Profile feature is designed only for the first-time HotSync 
operation, before you assign a User ID to a particular electronic notebook. 

To create a user profile:

1. Open Palm Desktop software.

2. From the Tools menu, choose Users.

3. Click Profiles. 

4. Click New. Enter a unique name for the profile, and click OK. 

5. Repeat steps 3 and 4 for each profile that you want to create. When you 
have finished, click OK to return to Palm Desktop software. 

6. Select the profile from the User list and create the data for the profile (for 
example, company phone list, and so on).
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To use a profile for the first-time HotSync operation:

1. Connect the new Dana to the computer via a USB cable.

2. Press function-sync.

3. Click Profiles.

4. Select the profile that you want to load on Dana, and click OK.

5. Click Yes to transfer all the profile data to Dana.

The next time you perform a HotSync operation, Palm Desktop software 
prompts you to assign a user name to Dana.

Selecting HotSync setup options
You can choose when you want HotSync Manager to run. If necessary, you 
can adjust the local and modem HotSync settings as well.

To set the HotSync options:

1. Open Palm Desktop software.

2. From the HotSync menu, choose Setup.

3. Click the General tab, and select one of the following options:

• Always Available adds HotSync Manager to the Startup folder and 
constantly monitors the communication port for synchronization 
requests from your electronic notebook. With this option, the 
HotSync Manager synchronizes data even when Palm Desktop 
software is not running.
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• Available Only When Palm Desktop software is running starts 
HotSync Manager and monitors requests automatically when you 
open Palm Desktop software.

• Manual monitors requests only when you select HotSync Manager 
from the Start menu.

If you’re not sure which option to use, keep the default setting, 
Always Available.

4. Click the Modem tab to display the modem settings and adjust the 
options as needed. See "Conducting a HotSync operation via modem" on 
page 185 for more information.

5. If you are attached to a network, click the Network tab to display the 
network settings and adjust the options as needed. See "Conducting a 
HotSync operation via a network" on page 189 for more information.

6. Click OK.

Customizing HotSync application settings
For each application, you can define a set of options that determines how 
records are handled during synchronization. These options are called a 
“conduit.” The conduit is the “transfer software”, and the options are set to 
tell the conduit what to transfer. By default, a HotSync operation 
synchronizes all files between Dana and Palm Desktop software. 

In general, you should leave the settings to synchronize all files. The only 
reason you might want to change these settings is to overwrite data on 
either Dana or Palm Desktop software, or to avoid synchronizing a 
particular type of file because you don’t use it.

In addition to the conduits for Date Book, Address Book, To Do List, Memo 
Pad, and AlphaWord, Palm Desktop software includes System and Install 
conduits. The System conduit backs up the system information stored on 
Dana. The Install conduit installs applications on Dana. 
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To customize HotSync application settings:

1. Click the HotSync icon in the Windows system tray (bottom right corner 
of the taskbar).

Tip: You can also click the HotSync command on the Palm Desktop software menu bar.

2. From the HotSync Manager menu, choose Custom.

3. Select the appropriate user name from the list.

4. Select an application in the Conduit list. Click Change.

5. Click the direction in which you want to write data, or click Do Nothing 
to skip data transfer for an application.

Click HotSync 
icon to show
options
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6. Choose how long the setting will remain in effect:

• To have the setting affect only the next HotSync operation, deselect 
Set As Default. Thereafter, the HotSync Actions revert to their 
default settings. 

• To use a new setting as the default, select the Set As Default option. 
Thereafter, whatever you selected as the default setting is used 
when you click the Default button in the Custom dialog.

7. Click OK.

8. Repeat steps 4 through 7 to change conduit settings for other 
applications.

9. Click Done to activate your settings.

Conducting a HotSync operation via modem
You can use a modem to synchronize with Dana when you are away from 
your computer. You must purchase a modem separately for use with Dana. 
See www.alphasmart.com for more information.

NOTE: The first HotSync operation must be local, using a USB cable. 
After that, you can perform a modem HotSync operation.

To perform a HotSync operation via modem you must complete the 
following steps:

• Connect a modem to your computer.

• Configure the Palm Desktop software for use with your modem.

• Connect a modem to Dana.

• Configure the Modem preferences on Dana for use with your 
modem. See "Setting Connection and Network Preferences" on page 
193.

Preparing your computer
You must perform a few steps to prepare your computer for a modem 
HotSync operation. Be sure to perform these steps before you leave your 
office so that your computer is ready to receive a call from Dana. 
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To prepare your computer for a modem HotSync operation:

1. Confirm that the computer modem is connected and turned on, and that 
no communications applications, such as fax or telephony software, are 
running on a COM port.

NOTE: Make sure that the computer is disconnected from all online 
services, such as America Online (AOL) and CompuServe, to avoid 
conflicts with the COM port.

2. Start HotSync Manager if it is not already running, and from the 
HotSync Manager menu, choose Modem.

3. Adjust the following options as needed: 

• Serial Port to identify the port for the modem. If you are unsure of 
the port assignment, look at the Modem Properties in the Windows 
Control Panel.

• Speed to determine the speed at which data is transferred. Try the 
As Fast As Possible rate first, and adjust downward if you 
experience problems. This setting lets Palm Desktop software and 
your electronic notebook find and use the fastest speed.

• Modem to identify the modem type or manufacturer. Refer to your 
modem manual or face plate for its type or settings. If you’re not 
sure of your modem type or your modem doesn’t match any that 
appear in the list, select Hayes Basic.

• Setup String to identify the setup string for your particular modem. 
Not all modems require a setup string. Refer to your modem 
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manual and enter the setup string if recommended by the 
manufacturer.

4. Click OK.

Preparing Dana
In addition to preparing your computer, you must perform a few steps to 
prepare Dana for a modem HotSync operation. 

To prepare Dana for a modem HotSync operation:

1. Tap the Applications icon. 

2. Tap the HotSync icon. 

3. Tap Modem and then tap the Enter Phone # field.

NOTE: If you plan to connect to your company’s dial-in server (network 
modem) instead of connecting to a computer modem, see "Conducting a 
HotSync operation via a network" on page 189.

4. Enter the telephone number to access the modem connected to your 
computer.

5. If needed, enter a dial prefix (such as “9”) to access an outside line, and 
then tap the Dial Prefix check box.

TIP: You can enter a comma in the field to introduce a “pause” in the 
dialing sequence. 
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6. If the phone line you’re using for the electronic notebook has Call 
Waiting, select the Disable call waiting check box to avoid an 
interruption during the modem HotSync operation. 

7. If you want to use a calling card to place the call, select the check box and 
enter the calling card number. 

8. Tap OK.

9. Tap the Menu icon. 

10. Tap Options, and then tap Connection Setup. Select Standard Modem 
and tap Edit.

11. Tap Via:, and then tap the correct connection method for your modem. If 
you are using a USB modem with Dana select USB Modem from the list. 
If you are using an Infrared modem make sure that is selected.

12. Enter the rest of the settings. See "Setting modem configurations" on 
page 194 for more information. 

Selecting conduits for a modem HotSync operation
You can define which files, applications, or both on your electronic 
notebook synchronize during a modem HotSync operation, to minimize 
the time required to synchronize data with a modem. To define what 
synchronizes, you use the Conduit Setup dialog box.

Applications that do not have a database (such as games) do not 
synchronize—even if you select the item in the Conduit Setup dialog box. 

To define which files or applications on Dana synchronize during a 
HotSync operation:

1. Tap the Applications icon. 

2. Tap the HotSync icon. 
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3. Tap the Menu icon. 

4. Tap Options, and then tap Conduit Setup.

5. In the Conduit Setup dialog box, tap the check boxes to deselect the files 
and applications that you do not want to synchronize during a modem 
HotSync operation. The default setting is to synchronize all files. 

6. Tap OK.

Performing a HotSync operation via a modem
After you prepare your computer and Dana, and select your Conduit Setup 
options, you are ready to perform a modem HotSync operation.

To perform a modem HotSync operation:

1. Tap the Applications icon. 

2. Tap the HotSync icon. 

3. Tap the Modem icon to dial the Palm Desktop modem and synchronize 
the applications.

4. Wait for the HotSync operation to complete.

Conducting a HotSync operation via a network
When you use the Network HotSync software, you can take advantage of 
the LAN and WAN connectivity available in many office environments. 
The Network HotSync software lets you perform a HotSync operation by 
dialing in to a network or by using a USB cable that is connected to any 
computer on your LAN or WAN (provided that the computer connected to 
the cable also has the Network HotSync software installed, your computer 
is on, and the HotSync Manager is running).
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The Network HotSync software requires the following:

• Your computer has TCP/IP support installed.

• Both your company’s network system and its remote access server 
support TCP/IP. (Your System Administrator has this information.)

• You have a remote access account. (If you don’t have an account, 
consult your System Administrator.)

Everything you need to connect to your company’s dial-in server (network 
modem) is included with Palm Desktop software and Dana. You need to 
activate the feature, however, on Palm Desktop software and Dana.

To prepare your computer for a network HotSync operation:

1. Click the HotSync Manager icon in the Windows system tray.

2. From the HotSync Manager menu, choose Network.

3. From the HotSync Manager menu, choose Setup.

4. Click the Network tab and make sure that a check mark appears next to 
your user name. If no check mark appears, select the check box next to 
your user name.

5. Click OK.
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6. Connect Dana via a USB cable, and perform a HotSync operation.

The HotSync operation records network information about your computer 
on Dana. With this information, Dana can locate your computer when you 
perform a HotSync operation over the network.

To prepare Dana for a network HotSync operation:

1. Tap the Applications icon. 

2. Tap the HotSync icon. 

3. Tap the Menu icon. 

4. Tap Options, then tap Modem Sync Prefs.

5. Tap Network.

6. Tap OK.

NOTE: See "Setting Connection and Network Preferences" on page 
193 for information on configuring Network HotSync preferences.

Using File Link
The File Link feature lets you import Address Book and Memo Pad 
information into your electronic notebook from a separate external file 
such as a company phone list. HotSync Manager stores the data in a 
separate category on your Palm Desktop software and your electronic 
notebook. You can set the File Link feature to check for changes to the 
external file when you perform a HotSync operation. 

With File Link, you can import data stored in any of the following file 
formats:

• Comma delimited (.csv).

• Tab delimited (.tsv).

• Memo Pad archive (.mpa).

• Address Book archive (.aba).

• Text (.txt).

For information on how to set up a file link, see the Palm Desktop online 
Help.
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13
Setting Connection 
and Network 
Preferences 
The TCP/IP software that is included in the Dana operating system lets 
you connect with remote Internet Service Providers (ISPs) or dial-in 
(remote access) servers, using applications that let you view the 
transmitted data. 

To use TCP/IP you will need to select a Network connection . You will 
need to configure a Connection to reach the network unless you're using 
the LAN network setting which automatically provides a connection (see 
"Connection preferences" on page 193 and "Network preferences" on page 
196). Then you connect to your ISP or dial-in server; see "Connecting to 
your ISP or dial-in service" on page 205.

Connection preferences
The Connection Preferences screen allows you to create configurations for 
communicating with a computer or modem. Configurations, or profiles, 
are then available to various end-user applications running on Dana. Once 
you have set up a configuration in connection preferences, you will then 
need to go into the various end-user applications (like HotSync) to select it 
as the default connection for that application. The Connection Preferences 
screen displays a list of available configurations that can be modified to 
reflect the required settings. This list will vary depending on the software 
you have added to Dana.
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Connection Types
There are three basic types of connections you can choose from when 
configuring your preferences. They are described here:

To modify Connection preferences:

1. Press the apps key repeatedly till you see ALL in the top right corner of 
the Applications Launcher.

2. Tap the Prefs application. 

3. In the pick list in the upper right corner of the screen, tap Connection.

Setting modem configurations
Modem configurations let Dana use a connected modem to communicate 
with remote devices, such as your ISP or dial-in server, to access a remote 
computer. 

You must set Network preferences, in addition to configuring Modem 
settings, to be able to use TCP/IP software included in the Dana operating 
system to connect to remote devices.

Cable A direct USB cable connection between Dana and your 
desktop computer. It is used when performing a local 
HotSync. Dana is connected via a USB cable to the USB port 
on your desktop computer.

Standard Modem A connection between Dana’s USB port and a modem for 
dialing in to a modem that is part of your computer. 

Infrared A connection between Dana’s IR port and the IR port on 
your computer.
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NOTE: You must purchase a modem separately for use with Dana. 
See www.alphasmart.com for more information.

To edit Standard Modem connection:

1. Press the apps key repeatedly till you see ALL in the top right corner of 
the Applications Launcher.

2. Tap the Prefs application. 

3. In the pick list in the upper right corner of the screen, tap Connection.

4. In the Connection Panel select Standard Modem and tap Edit.

5. The name of the current configuration appears at the top of the screen.

6. Tap the Connect to: pick list and select the device to connect to.

7. Tap the Via: pick list and select the type of connection. For example if 
you are connecting to an Infrared modem, choose Via: Infrared.

8. In the Dialing pick list tap TouchTone or Rotary. Select Rotary only if 
your telephone service does not support TouchTone dialing.

9. Tap the Volume pick list and select the speaker volume for the modem.

10. Tap the Details button at the bottom of the screen
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11. Tap the Speed pick list and select the maximum speed for your modem 
to communicate with Dana. (This setting does not control the speed at 
which your modem communicates with your telephone service.)

12. Tap the Flow Control (Flow Ctl) pick list, and select Automatic, On 
(Xon), or Off (Xoff) flow control for the modem connection.

13. If necessary, edit the Init String text to change the modem setup string. 

14. Tap OK through each screen until you are returned to the Connection 
Preferences screen.

Network preferences
You must set Network preferences, as well as Connection preferences, to be 
able to use the TCP/IP software included in the Dana operating system for 
remote connections. 

Network preferences let you set a password, telephone number, DNS 
number, IP address, as well as create a login script for remote connections. 
You can use a preset service template for your ISP or dial-in server, and 
edit, save, and reuse settings. Or you can create your own service template.

To set network preferences:

1. Press the apps key repeatedly till you see ALL in the top right corner of 
the Applications Launcher; then tap the Prefs icon.

2. In the upper right corner of the Preferences screen, tap Network.
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3. Tap the Service pick list. Tap the predefined service template you want 
to use.

4. Tap the User Name field. Only two lines appear onscreen, but the field 
can contain multiple lines of text.

5. Enter your user name that identifies you on logging in to your ISP or 
dial-in server. Do not enter spaces in your user name unless your dial-in 
server accepts them. 

6. Choose whether to use a password when logging onto your ISP or dial-
up service:

• To not be prompted for a password during log-on, tap the Password 
field. Enter your password and tap OK. “Assigned” appears in the 
field. 

• To have Dana prompt you for the password during log-on, leave 
“Prompt” in the Password field and do not enter anything. You 
should choose this option if you’re concerned about security. 

Tap to display a list of 
service templates.

Enter your user name 
here.
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7. Tap the Connection pick list and select one. The list includes the 
configurations displayed in your Connection Preferences panel.

8. Tap the Phone Number field to display the Phone Setup dialog box.

9. Enter the phone number you use to reach your ISP or dial-in server. 

10. If you need to enter a prefix or disable Call Waiting, skip to the next 
steps. Otherwise, tap OK.

11. To enter a prefix before the telephone number to access an outside line, 
tap the Dial Prefix check box, and enter the prefix. For example, many 
offices require that you dial “9” to dial a number outside the building.

Enter password.

Tap here.

Tap to display a list of 
connection configurations.

Enter your ISP phone 
number.
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12. To turn off Call Waiting, tap the Disable call waiting check box to select 
it, and enter the code to turn off Call Waiting. (If you don’t know the 
code, contact your local telephone company for the appropriate code.) 
Call Waiting can end your network session if you receive a call while 
you are connected.

13. To use a calling card to dial your ISP or dial-up service, tap the Use 
Calling Card check box. On the Use Calling Card line, enter three 
commas. (Each comma delays transmission of your calling card number 
for two seconds, to compensate for the delay before the number is 
entered.) Enter your calling card number. 

NOTE: MCI customers must enter the calling card number in the 
Phone # field, and the phone number in the Use Calling Card field.

Enter your 
prefix.Select to use a 

prefix.

Enter your disable code.

Select to turn 
off Call Wait-
ing.
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14. When you have finished setting up your phone number, tap OK.

Customizing service templates
You can create your own service templates from scratch or duplicate 
existing templates and edit the information. 

If you use one of the predefined service templates, you probably only need 
to enter your user name and telephone number. If you create a new service 
template, you may have to provide additional information.

To create a new service template:

1. Press the apps key repeatedly till you see ALL in the top right corner of 
the Applications Launcher; then tap the Prefs icon.

2. In the upper right corner of the Preferences screen, tap Network.

3. Press the menu key. 

4. Tap Service, and then tap New.

5. A new service template (called Untitled) is added to the Service pick list.

To duplicate an existing service template:

1. Press the apps key repeatedly till you see ALL in the top right corner of 
the Applications Launcher; then tap the Prefs icon.

2. In the upper right corner of the Preferences screen, tap Network.

3. In the Network Preferences screen, tap the Service pick list. Tap the 
predefined service template you want to duplicate.

4. Press the menu key. 

5. Tap Service, and then tap Duplicate.

A copy of the service template is added to the Service pick list.

Enter your calling 
card number.

Select to use a 
calling card.
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To edit a service template: 

1. In the Network Preferences screen, select a service template. 

2. Tap Details.

3. Tap the Connection Type pick list, and select a connection type:

• PPP for Point-to-Point protocol. Select this type if you’re unsure 
which you need. If PPP doesn’t work, ask your ISP or your system 
administrator for the correct connection type.

• SLIP for Serial Line Internet protocol

• CSLIP for Compressed Serial Line Internet protocol

4. Tap the Idle Timeout pick list to specify how long your electronic 
notebook waits to drop your connection when you switch out of a TCP/
IP application, and select Immediate, 1 minute, 2 minutes, 3 minutes, or 
Never (until the power is off or your electronic notebook times out).

5. Enter a DNS number following the instructions in the next section. 

6. Tap OK.

To delete a service template:

1. Tap the Service pick list.

2. Tap the service template you want to delete.

3. Press the menu key. 

4. Tap Service, and then tap Delete.

5. Tap OK.

Select connection type.
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Entering DNS numbers and IP addresses
The Internet uses the Domain Naming System (DNS) to translate the 
names of host computers into IP addresses. A DNS number (or IP address) 
identifies a specific server that handles the translation services. Each DNS 
or IP address is a series of four numbers, from 0 to 255, separated by 
periods.

Anyone who logs onto the Internet must have a unique identifier—an IP 
address. This IP address can be either temporary—assigned automatically 
each time you log on—or permanent. 

Not all systems require that you enter a DNS number; check whether it is 
with your system administrator. If a DNS number is required but not 
entered, logging on to your network may appear successful. However, the 
connection will fail if you try to use an application or look up information.

To specify a primary and secondary DNS number:

1. If your system requires DNS numbers, ask your Internet Service 
Provider or system administrator whether your system requires DNS 
numbers, and if so, what they are. 

NOTE: Many systems do not require that you enter a DNS. 

2. In the Network Preferences screen with a service template selected, tap 
Details. 

3. Tap the Query DNS check box to deselect it.

4. Choose one of the following options:

• If your system doesn’t require a DNS or you’re not sure whether it 
does, leave the DNS field blank. 

• To enter the Primary DNS number, tap the space to the left of the 
first period in the Primary DNS field and enter the first section of 
the IP address using a number only, from 0 to 255; repeat the step 
for the remaining sections of the field. Use the same technique to 
enter the Secondary DNS number.

To specify the IP address: 

1. Check with your system administrator whether your IP address is 
automatically (temporarily), or permanently assigned, and if permanent, 
get the address.
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2. In the Network Preferences screen, with a service template selected, tap 
Details. 

3. Choose one of the following options:

• If your IP address is automatic and temporary, make sure that the IP 
Address check box is selected.

• If your IP address is permanently assigned, tap the IP Address 
check box to deselect it. In the permanent IP address field, tap the 
space to the left of the first period, and enter the first section of the 
IP address using a number only, from 0 to 255. Repeat the step for 
the remaining sections of the field.

4. Tap OK.

Creating a login script
A login script is a series of commands that automates logging into your ISP. 

You can create login script files by selecting commands from in the Login 
Script dialog box. Some commands, such as Send, require additional 
information and have a parameter field to add the necessary data. 

You can also use non-ASCII and literal characters in your login script. See 
"Using non-ASCII characters in login scripts" on page 205 for more 
information.

To create a login script:

1. With a service template selected in the Network Preferences screen, tap 
Details.

2. In the Details dialog box, tap Script.

3. In the Login Script screen, tap the End pick list.

Tap to select automatic IP 
address.



204 Sett ing Connection and Network Preferences

4. In the pick list, tap any of the following commands to select them, and 
then enter additional information if a field appears:

• Wait For to instruct Dana to wait for specific characters from the 
TCP/IP server before executing the next command.

• Send to transmit specific characters to the TCP/IP server to which 
you are connecting.

• Send CR to transmit a carriage return or LF character to the TCP/IP 
server to which you are connecting.

• Send User ID to transmit the User ID information entered in the 
User ID field of the Network Preferences screen.

• Send Password to transmit the password entered in the Password 
field of the Network Preferences screen. If you did not enter a 
password, this command prompts you to enter one. The Password 
command is usually followed by a Send CR command.

• Delay to instruct your electronic notebook to wait a specific number 
of seconds before executing the next command in the login script.

• Get IP (for SLIP connections) to read an IP address and uses it as the 
IP address for your electronic notebook. 

• Prompt to open a dialog box and prompts you to enter text of some 
kind (for example, a password or a security code).

• End to identify the last line in the login script.

5. Repeat steps 2 and 3 until you have completed the login script.

6. Tap OK, and then tap OK in the Details dialog box.

Tap here.
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Using non-ASCII characters in login scripts
If you know how to write custom scripts with non-ASCII characters, you 
can incorporate the caret (^char) character, carriage returns and line feeds, 
and literal characters in your custom login scripts.

• Use the caret (^ char) character to transmit ASCII command 
characters. If you send ^char, and the ASCII value of char is 
between @ and _, then the character is automatically translated to a 
single-byte value between 0 and 31. 

For example, ^M is converted to a carriage return. If char is a value 
between a and z, then the character sequence is translated to a 
single-byte value between 1 and 26. If char is any other value, then 
the character sequence is not subject to any special processing. Thus, 
the string “Joe^M” transmits Joe, followed by a carriage return.

• You can include carriage return and line feed commands as part of 
the login script, when entered in the following format:

<cr>Sends or receives a carriage return

<lf>Sends or receives a line feed

For example, the string “waitfor Joe<cr><lf>” waits to receive Joe, 
followed by a carriage return and line feed from the remote 
computer, before executing the next command in the script.

• You can use the backslash ( \ ) character to specify that the next 
character be transmitted as a literal character, and not be subject to 
any special processing ordinarily associated with that character. For 
example:

\^Includes a caret as part of the string

\<Includes a < as part of the string

\\Includes a backslash as part of the string

Connecting to your ISP or dial-in service
Once you’ve set Modem and Network preferences, you can easily connect 
to your ISP or dial-in server using PPP, SLIP, or CSLIP protocols. 

You can make the connection using either Network Preferences commands 
or a third-party application. Connecting to an ISP requires a third-party 
application, such as a Web browser or news reader. 
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To make or close a connection:

1. Press the apps key repeatedly till you see ALL in the top right corner of 
the Applications Launcher; then tap the Prefs icon.

2. In the upper right corner of the Preferences screen, tap Network.

3. In the Network Preferences screen, tap Connect to dial the current 
service and display the Service Connection Progress messages. 

4. To see expanded Service Connection Progress messages, press the lower 
half of the Scroll button during login.

5. Tap Disconnect to terminate the connection between your electronic 
notebook and your service.

Troubleshooting TCP/IP connections
If you have problems connecting to a network using TCP/IP, you can 
display information to troubleshoot the problem. You can display 
expanded Service Connection Progress messages. You can also display the 
Network Log to see all communication between your modem and dial-in 
server during login. This information can help your ISP or your System 
Administrator identify where and why the login communication fails.

In addition, check with your system administrator whether a DNS number 
if required. If a number is required but not entered, the connection may 
fail. See "Entering DNS numbers and IP addresses" on page 202.

To expand the display of progress messages during login:

1. In the Network Preferences screen, tap Connect. 

2. To see expanded Service Connection Progress messages, press the lower 
half of the Scroll button during login.

See "Connecting to your ISP or dial-in service" on page 205 for more 
information.

To view the Network Log:

1. With the Network Preferences screen displayed, press the menu key.

2. Tap Options, and then tap View Log.

3. Tap the Up and Down arrows of the scroll bar to see the entire Network 
Log.
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4. Tap Done.
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14
Maintaining your 
Electronic Notebook
This chapter provides information on the following:

• Proper care of Dana

• Prolonging battery life

• Resetting Dana

• Installing alkaline batteries

Caring for your electronic notebook
Dana is designed to be rugged and reliable and to provide years of trouble-
free service. Please observe the following general tips when using your 
electronic notebook:

• Take care not to scratch the screen of your electronic notebook. Keep 
the screen clean. When working with your electronic notebook, use 
the supplied stylus or plastic-tipped pens intended for use with a 
touch-sensitive screen. Never use an actual pen or pencil or other 
sharp object on the surface of the Dana screen.

• Your electronic notebook is not waterproof and should not be 
exposed to rain or moisture. In general, treat your electronic 
notebook as you would a pocket calculator or other electronic 
instrument.

• The touch-sensitive screen of your electronic notebook contains a 
glass element. Take care not to drop your electronic notebook or 
subject it to any strong impact. 

• Protect your electronic notebook from temperature extremes. Do 
not leave your electronic notebook on the dashboard of a car on a 
hot day, and keep it away from heaters and other heat sources.
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• Do not store or use your electronic notebook in any location that is 
extremely dusty, damp, or wet.

• Use a soft, damp cloth to clean your electronic notebook. If the 
surface of the screen becomes soiled, clean it with a soft cloth 
moistened with a diluted window-cleaning solution

Battery considerations
Please note the following considerations for the batteries in your electronic 
notebook:

• Under normal conditions, a fully charged Dana should run for over 
25 hours. You can conserve battery life by minimizing the use of the 
backlight feature, and changing the Auto-off setting that 
automatically turns Dana off after a period of inactivity. See "Setting 
the auto-off delay time" on page 163 for more information.

• If the batteries become low in the course of normal use, an alert 
appears on the electronic notebook screen describing the low 
battery condition. If this alert appears, connect Dana to the AC 
Adapter or computer via a USB cable immediately to recharge it, 
then perform a HotSync ® operation to back up your data. This 
helps prevent accidental data loss.

• When installing alkaline batteries or replacing a rechargeable 
battery, begin by turning Dana off (so there is no screen display). 
Never remove the batteries while your electronic notebook is turned 
on. When you remove the batteries, the built-in backup power of 
Dana maintains memory data for a period of up to one minute. 
Whenever you remove alkaline batteries, replace them immediately. 
If you encounter any difficulties in the course of battery 
replacement, reinstall the original batteries and wait a few minutes 
for the backup power to recharge.

• If the batteries drain to the point where Dana does not operate, it 
stores your data safely for about a month. In this case, there is 
enough residual energy in the batteries to store the data, but not 
enough to turn on your electronic notebook. If Dana does not turn 
on when you press the on/off key, you should recharge the unit 
immediately.

• If your battery drains and you have the unit in an uncharged state 
for an extended period of time, you can lose all of the stored data. If 
this happens, recharge the batteries and reset your electronic 
notebook. (See "Resetting Dana" on page 211 for details.) After you 
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reset Dana, perform a HotSync operation to restore the data from 
your computer.

Resetting Dana
Under normal circumstances, you will not have to use the reset button. On 
rare occasions, however, Dana may no longer respond to the keyboard or 
tapping the screen. In this case, you need to perform a reset to get Dana 
running again.

Performing a soft reset

A soft reset tells Dana to stop what it’s doing and start over again while 
retaining all records and entries stored in Dana.

• Use the tip of an unfolded paper clip (or similar object without a 
sharp tip) to gently press the reset button inside the hole on the back 
panel of Dana. 

Performing a hard reset

IMPORTANT: With a hard reset, all files, records and entries stored in 
Dana are erased. Never perform a hard reset unless a soft reset does 
not solve your problem. You can restore any data previously 
synchronized with your computer during the next HotSync operation.

1. While holding down the on/off key, use the tip of an unfolded paper clip 
(or similar object without a sharp tip) to gently press and release the 
reset button

2. Wait for the Palm logo to appear and release the on/off key.



212 Maintaining your Electronic Notebook

3. A warning will appear that you are about to erase all the data stored on 
Dana. Either press the up arrow key to complete the hard reset, or press 
the memo key to perform a soft reset. 

NOTE: When you perform a hard reset, the current date and time are 
retained. Formats, preferences, and other settings are restored to their 
factory default settings

Installing alkaline batteries:
If there is a situation where you are unable to recharge Dana using the USB 
cable or AC adapter, Dana will also operate using 3 AA batteries.

1. Turn Dana off.

2. Remove optional screw (if installed). 

3. Slide the battery door to the left and lift it off.

4. Remove the rechargeable battery but DO NOT unclip it.

5. Place 3 AA alkaline batteries in the battery compartment (positive to 
right).

WARNING! To avoid data loss when changing alkaline batteries, 
always turn Dana off before removing batteries, then replace the 
batteries within 30 seconds.
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6. Unclip the rechargeable battery.

7. Replace the battery door and slide it to the right to lock it in place.

To restore your data from a PC after a hard reset:

1. Click the HotSync Manager icon  in the Windows system tray 
(bottom-right corner of the taskbar).

TIP: You can also click the HotSync command on the Palm Desktop 
software menu bar.

2. From the HotSync Manager menu, choose Custom.

3. Select the appropriate user name from the list.

4. Select an application in the Conduit list.

Battery To Dana

Battery Clip in place

Push to release



214 Maintaining your Electronic Notebook

5. Click Change.

6. Select Desktop overwrites handheld.

NOTE: Changing the HotSync setting from the default affects only the 
next HotSync operation. Thereafter, the HotSync Actions revert to their 
default settings.

7. Click OK.

8. Repeat steps 4 through 7 to change conduit settings for other 
applications.

9. Click Done to activate your settings.

10. Perform a HotSync operation.

To restore your data from a Macintosh after a hard reset:

1. Double-click the HotSync Manager in the Palm folder.

2. From the HotSync menu, choose Conduit Settings.
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3. From the Users pop-up menu, select the appropriate user name.

4. Select an application in the Conduit list.

5. Click Conduit Settings.

6. Select Macintosh overwrites handheld.

NOTE: Changing the HotSync setting from the default affects only the 
next HotSync operation. Thereafter, the HotSync Actions revert to their 
default settings.

7. Click OK.

8. Repeat steps 4 through 7 to change conduit settings for other 
applications.

9. Close the Conduit Settings window.

10. Perform a HotSync operation.
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15
Frequently Asked 
Questions 
If you encounter a problem with Dana:

• Review this section to see if your problem is listed

• Check our web site at www.alphasmart.com for the latest technical 
support information

NOTE: There are thousands of third-party applications available for 
Palm OS® devices like Dana. For questions and support on these non-
AlphaSmart applications, please contact the software developer directly.

Software installation problems

The Palm Desktop Installer Menu did not appear when I inserted the 
CD-ROM into my Windows Computer

1. Click the Start button.

2. Choose Run from the Start menu.

3. Click Browse.

4. Locate your CD-ROM drive and select the Setup.exe file.

5. Click Open.

6. Click OK.

I cannot install Palm Desktop software on a Windows computer

1. Disable any virus scanning software on your computer.

2. Press CTRL-ALT-DELETE and end all tasks except Systray and Explorer.



218 Frequently Asked Questions

TIP: If a dialog with buttons appears instead of list of tasks, click the 
Task List button and then end all tasks except Systray and Explorer.

3. Make sure your computer has at least 30 MB of disk space available.

4. Delete all temporary files.

5. Run ScanDisk on your computer.

6. Reinstall Palm Desktop software.

I cannot install Palm Desktop software on a Macintosh computer

1. Disable any virus scanning software on your computer.

2. Quit any open applications.

3. Make sure your computer has at least 25 MB of disk space available.

4. Reinstall Palm Desktop software.

Operating problems

I don’t see anything on my Dana screen

Try each of these in turn:

• Press the on/off key to ensure your Dana is turned on.

• Press the function-contrast key. If the Contrast dialog box appears, 
adjust the contrast by holding down the function-PgUp key for a 
few seconds. If this doesn’t work, hold the function-PgDn key for a 
few seconds.

• Make sure the battery is properly charged.

• Perform a soft reset. If Dana still doesn’t turn on, perform a hard 
reset. See "Performing a hard reset" on page 211. 
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IMPORTANT: With a hard reset, all records and entries stored in Dana 
are erased. Never perform a hard reset unless a soft reset does not 
solve your problem. You can restore any data previously synchronized 
with your computer during the next HotSync operation. See "To restore 
your data from a PC after a hard reset:" on page 213 or "To restore your 
data from a Macintosh after a hard reset:" on page 214 for instructions 
on restoring your data.

I get a warning message telling me Dana’s memory is full.

• Purge Date Book and To Do List. This deletes To Do List items and 
past Date Book events from the memory of your Dana. See "Purging 
records" on page 130. You may need to perform a HotSync 
operation to recover the memory.

• Delete unused memos and records. If necessary, you can save these 
records. See "Using the Edit menu" on page 128.

• If you have installed additional applications on Dana, remove them 
to recover memory. See "Removing applications" on page 58. 

My Dana keeps turning itself off.

Your Dana is designed to turn itself off after a period of inactivity. This 
period can be set at 30 seconds, one, three, five, ten, or twenty minutes. 
Check the Auto-off setting. See "Setting the auto-off delay time" on page 
163.

My Dana is not making any sounds.

Check the System Sound setting. See "Setting the sounds and volumes" on 
page 164.

My Dana has frozen.

Perform a soft reset. See "Performing a soft reset" on page 211.

Tapping and writing problems

When I tap the buttons or screen icons, it activates the wrong 
feature.

Calibrate the screen. See "Digitizer preferences" on page 162.
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When I tap the Menu icon, nothing happens.

Not all applications or screens have menus. Try changing to a different 
application.

I can’t get my Dana to recognize my handwriting.

• For your Dana to recognize hand-writing input with the stylus, you 
need to use Graffiti ® writing. See "Entering data using Graffiti 2 
handwriting software" on page 38.

• Make the Graffiti character strokes in the Graffiti writing area, not 
on the display part of the screen.

• Write Graffiti strokes for letters in the left-hand side, and the strokes 
for numbers in the right-hand side of the Graffiti writing area.

• Make sure that Graffiti is not shifted into extended or punctuation 
modes. See "Writing symbols and extended characters" on page 45.

• See "Graffiti 2 tips" on page 41 for tips on increasing your accuracy 
when you write Graffiti characters.

Application problems

I tapped the Today button, but it does not show the correct date.

Your Dana is not set to the current date. Make sure the Set Date box in the 
General Preferences screen displays the current date. See "General 
preferences" on page 163 for more information.

I know I entered some records, but they do not appear in the 
application.

• Check the Categories pick list (upper-right corner of the screen). 
Choose All to display all of the records for the application.

• Check Security and make sure that the Private Records setting is set 
to Show private records.

• In To Do List, tap Show and check whether Show Only Due Items is 
selected.

I am having problems listing memos the way I want to see them.

• If you cannot manually arrange the order of the memos in the List 
screen, check the Memo Preferences setting. Make sure that Sort by 
is set to Manual.
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• If you choose to view your memos alphabetically on Palm Desktop 
software and then perform a HotSync operation, the memos on 
your Dana still appear in the order defined in the Memo Preferences 
setting. In other words, the sort settings that you use with Palm 
Desktop software are not transferred to Dana.

I created an event in Date Book, but it doesn’t appear in the Week 
View.

In the Week View, you cannot select overlapping events that have the same 
start time. If you have two or more events with the same start time, choose 
the Day View for the particular day to see the overlapping events.

HotSync problems

I cannot do a HotSync operation; what should I check to make sure I 
am doing it correctly?

• Make sure the USB cable is connected securely to Dana and your 
computer.

On a PC try these steps:

• Check the Windows system tray to make sure the HotSync Manager 
is running. If it is not, open Palm Desktop software.

• Click the HotSync Manager and make sure that the Local USB 
option has a check next to it. 

On a Macintosh computer try these steps:

• Make sure HotSync Manager is enabled. If it is not, double-click the 
HotSync Manager icon in the Palm folder and enable HotSync 
Manager on the HotSync Controls tab.

I did a HotSync operation, but one of my applications did not 
synchronize.

• On a PC, click the HotSync Manager and choose Custom. Check 
that the correct conduit is active.

• On a Macintosh, double-click the HotSync Manager icon. From the 
HotSync menu, choose Conduit Settings. Select your user name 
from the User pop-up menu, and check that the correct conduit is 
active.
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I am using Outlook as my PIM, but I cannot do a HotSync operation.

• Click the HotSync Manager and choose Custom. Check that the 
correct conduit is active.

• Check that the correct conduit is installed. Reinstall the HotSync 
Manager and make sure the correct conduit is selected.

I cannot launch the HotSync Manager.

• If you are performing a HotSync operation using a modem, make 
sure you are not running another program, such as America Online, 
CompuServe, or WinFax, that uses the port you selected in the 
Setup dialog box.

• Reinstall the Palm Desktop software.

I tried to do a local HotSync operation, but it did not complete 
successfully.

• Check the connection between Dana and the USB port on your 
computer.

• Make sure the user name you selected in Palm Desktop software 
matches the user name assigned to your electronic notebook.

• Make sure the date on your computer matches the date on your 
electronic notebook.

• Read the HotSync Log for the user account for which you are 
performing a HotSync operation.

On a PC, try each step in turn:

• Make sure HotSync Manager is running. If HotSync Manager is 
running, exit and restart it.

• Make sure you selected Local from the HotSync Manager menu or 
the Palm Desktop software menu.

• Click the HotSync Manager and make sure that the Local USB 
option has a check next to it. 

On a Macintosh, try each step in turn:

• Make sure HotSync Manager is enabled on the HotSync Controls 
tab in the HotSync Software Setup window.
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I tried to do a modem HotSync operation, but it did not complete 
successfully.

Check the following on your computer:

• Make sure your computer is turned on and that it does not shut 
down automatically as part of an energy-saving feature.

• Make sure the modem connected to your computer is turned on and 
is connected to the outgoing phone line.

• Make sure the modem you are using with your Dana has an on-off 
switch. Dana cannot “wake up” a modem that has an auto-off 
feature.

• Make sure the modem is connected properly to a serial port on your 
computer and is connected to the incoming phone line.

On a PC, check the following:

• Make sure Modem is checked in the HotSync Manager menu.

• Confirm that the Setup String in the Setup dialog box configures 
your modem correctly. You may need to select a different Modem 
Type or enter a custom Setup String. Most modems have a Setup 
String that causes them to send initial connection sounds to a 
speaker. You can use these sounds to check the modem connection.

• Confirm that the Speed setting in the Setup dialog box works for 
your modem. If you have problems using the As Fast As Possible 
option or a specific speed, try using a slower speed.

• Make sure you are not running another program, such as WinFax, 
CompuServe, or America Online, that uses the serial port you 
selected in the Setup dialog box.

• Make sure your modem resets before you try again. (Turn off your 
modem, wait a minute, then turn it back on.)

On a Macintosh, check the following:

• Make sure Modem is selected on the Serial Port Settings tab in the 
HotSync Software Setup window.

• You may need to select a different Modem type or enter a Custom 
setup string on the Serial Port Settings tab. Most modems have a 
setup string that causes them to send initial connection sounds to a 
speaker. You can turn on the Modem Speaker option and user these 
sounds to check the modem connection.
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• Make sure you are not running another program, such as America 
Online, fax or telephony software, or AppleTalk networking that 
uses the serial port you selected in the Serial Port Settings tab.

• Make sure your modem resets before you try again. (Turn off your 
modem, wait a minute, then turn it back on.)

Check the following on Dana:

• Confirm that the telephone cable is securely attached to your 
modem.

• Make sure the dialing instruction dials the correct phone number.

• If you need to dial an outside line prefix, make sure you selected the 
Dial Prefix option on Dana and entered the correct code.

• If the telephone line you are using has Call Waiting, make sure you 
selected the Disable call waiting option under Modem Sync Phone 
Setup on Dana and entered the correct code.

• Make sure the telephone line you are using is not noisy, which can 
interrupt communications.

• Check the batteries in your modem and replace them if necessary.

Dana appears to freeze when I place it near my computer.

Move Dana away from the computer ’s infrared port.

When I press function-sync to initiate a HotSync, nothing happens 
on Palm Desktop software and Dana times out.

• Turn on Dana and tap the Applications icon. Tap the HotSync icon, 
then tap Local.

• Make a copy of your Palm folder. Uninstall, then reinstall Palm 
Desktop software.

When I perform a HotSync operation, my information does not 
transfer to Palm Desktop software.

• If you have performed a HotSync operation successfully, but you 
cannot find the data from Dana on Palm Desktop software, check to 
see you have the correct user name selected for viewing data.

• On a PC, click the HotSync Manager and choose Custom. Check 
that all the conduits are set to synchronize files.
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• On a Macintosh, double-click the HotSync Manager icon. From the 
HotSync menu, choose Conduit Settings. Select you user name from 
the User pop-up menu, and check that the correct conduit is active.

Dana displays the message “Waiting for sender” when it’s near my 
computer’s infrared port.

• Your computer’s infrared port may be set to search automatically 
for the presence of other infrared devices. Consult the 
documentation for your operating system for information about 
turning off this option. 

• In some cases, simply moving Dana away from the computer’s 
infrared port solves the problem.

I want to synchronize my computer with more than one Dana or other 
Palm OS device.

• If the computer running Palm Desktop software synchronizes with 
more than one Dana or other Palm OS device, each device must 
have a unique user name. Assign a user name to Dana the first time 
you perform a HotSync operation.

• Please be aware that synchronizing more than one Dana or other 
Palm OS device with the same user name causes unpredictable 
results and, potentially, loss of your personal information.

Beaming problems

I cannot beam data to another Dana or Palm OS device.

• Confirm that your Dana and the other Dana are between ten 
centimeters (approximately 4") and one meter (approximately 39") 
apart, and that the path between the two Danas is clear of obstacles. 
Beaming distance to other handheld computers based on the Palm 
Computing platform may be different.

• Move Dana closer to the receiving device.

• Perform a soft reset. See "Performing a soft reset" on page 211 for 
more information.
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When someone beams data to my Dana, I get a message telling me it 
is out of memory.

• Dana requires at least twice the amount of memory available as the 
data you are receiving. For example, if you are receiving a 30K 
application, you must have at least 60K free.

• Perform a soft reset. See "Performing a soft reset" on page 211 for 
more information.

Password problems

I forgot my password, and my Dana is not locked.

• First, use the password hint to try to remember the password. If this 
does not help, you can use Security to delete the password. If you 
do this, Dana deletes all entries marked as private. However, if you 
perform a HotSync operation before you delete the password: the 
HotSync process backs up all entries, whether or not they are 
marked private. In this case, the following procedure restores your 
private entries and lets you access them:

1. Use the Palm Desktop software and USB cable to synchronize your data.

2. Tap Forgotten Password in Security to remove the password and delete 
all private records.

3. Perform a HotSync operation to synchronize your data and restore the 
private records by transferring them from your computer to Dana.

I forgot the password and my Dana is locked.

• First, use the password hint to try to remember the password. If this 
does not help, you must perform a hard reset to continue using 
Dana. See "Performing a hard reset" on page 211 for more 
information.
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APPENDIX A
Warranty 
AlphaSmart, Inc. warrants the Dana keyboard and display to be free from 
defects in materials and workmanship for a period of one year from the 
date of original retail purchase. 

During this period, if a defect should occur, AlphaSmart, Inc. will, at its 
option, repair or replace Dana at no charge to you, provided that it is 
returned during the warranty period to AlphaSmart, Inc. or one of its 
authorized dealers. This warranty does not apply if Dana has been 
damaged by accident or abuse, or modified without the written permission 
of AlphaSmart, Inc., or if the serial number has been removed or defaced. 

There are no other warranties, express or implied. AlphaSmart, Inc. accepts 
no responsibility for consequential damages, including, but not limited to, 
loss of profit or benefits.

For AlphaSmart contact information and return procedures refer to the 
Getting Started with Dana guide.
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APPENDIX B
International and 
Special Characters
The Dana keyboard is capable of the full range of special characters and 
typographical options available in the Palm OS. The tables below display 
the keyboard commands that produce these characters.

NOTE: Any key commands that use a “two-key” command separated 
by a hyphen (i.e. function-^) are executed by pressing the indicated keys 
simultaneously.

Table 16. Diacritical Characters

Character Standard Keystroke(s) Notes

á a key followed by Function-" acute accent

é e key followed by Function-" acute accent

í i key followed by Function-" acute accent

ó o key followed by Function-" acute accent

ú u key followed by Function-" acute accent

Á A key followed by Function-" acute accent

É E key followed by Function-" acute accent

Í I key followed by Function-" acute accent

Ó O key followed by Function-" acute accent
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Ú U key followed by Function-" acute accent

à a key followed by Function-~ grave accent

è e key followed by Function-~ grave accent

ì i key followed by Function-~ grave accent

ò o key followed by Function-~ grave accent

ù u key followed by Function-~ grave accent

À A key followed by Function-~ grave accent

È E key followed by Function-~ grave accent

Ì I key followed by Function-~ grave accent

Ò O key followed by Function-~ grave accent

Ù U key followed by Function-~ grave accent

â a key followed by Function-^ circumflex accent

ê e key followed by Function-^ circumflex accent

î i key followed by Function-^ circumflex accent

ô o key followed by Function-^ circumflex accent

û u key followed by Function-^ circumflex accent

Â A key followed by Function-^ circumflex accent

Ê E key followed by Function-^ circumflex accent

Î I key followed by Function-^ circumflex accent

Ô O key followed by Function-^ circumflex accent

Û U key followed by Function-^ circumflex accent

ä a key followed by Function-: dieresis accent

ë e key followed by Function-: dieresis accent

ï i key followed by Function-: dieresis accent
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Table 17. Special Characters

ö o key followed by Function-: dieresis accent

ü u key followed by Function-: dieresis accent

ÿ y key followed by Function-: dieresis accent

Ä A key followed by Function-: dieresis accent

Ë E key followed by Function-: dieresis accent

Ï I key followed by Function-: dieresis accent

Ö O key followed by Function-: dieresis accent

Ü U key followed by Function-: dieresis accent

Ÿ Y key followed by Function-: dieresis accent

ã  a key followed by Function-Shift-~ tilde accent

ñ n key followed by Function-Shift-~ tilde accent

õ o key followed by Function-Shift-~ tilde accent

Ã A key followed by Function-Shift-~ tilde accent

Ñ N key followed by Function-Shift-~ tilde accent

Õ O key followed by Function-Shift-~ tilde accent

å a key followed by Function-( dot accent

Å A key followed by Function-( dot accent

Character Standard Keystroke(s) Notes

ø Function-o

Ø Function-Shift-o

° Function-d

™ Function-t
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Table 18. Punctuation

® Function-r

© Function-g

ç Function-c

Ç Function-Shift-c

§ Function-s

¶ Function-\

æ Function-a

Æ Function-Shift-a

• Function-w

Character Standard 
Keystroke(s)

Notes

¿ Function-/

¡ Function-1

» Function-. Function key and period key

« Function-, Function key and comma key

‘ Function-[

’ Function-]

“ Function-Shift-[

” Function-Shift-]
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Table 19. Accents

Table 20. Currency

Table 21. Math

Character Standard Keystroke(s) Notes

` (grave accent) ` 

^ (circumflex) Shift-^

~ (tilde) Shift-~

Character Standard Keystroke(s) Notes

€ Function-e

£ Function-p

¢ Function-5

¤ Function-j

¥ Function-y

$ Shift-4

Character Standard Keystroke(s) Notes

½ Function-2

¼ Function-4

¾ Function-3

÷ Function- - Function key and hyphen key 

± Function-=

ƒ Function-f



234 International and Special  Characters

Table 22. Greek

Character Standard Keystroke(s) Notes

ß Function-b beta or German Sharp S

µ Function-u mu
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APPENDIX C
Configuring an 
Infrared Modem for 
Dana and Aileron 
This appendix covers how to setup your infrared modem, Dana and 
computer to work with the Aileron email program. If you are using 
another email program you can still use this as a general guideline, but you 
will need to enter the settings specific to the email program you are using. 

Setting up your infrared modem
If your Dana did not come with a modem, you can still purchase a modem 
separately for use with Dana. See www.alphasmart.com for more 
information.

To prepare your modem:

1. Insert the correct batteries (not included) for you modem, or if your 
modem came with an AC Adapter attach that to the modem and plug it 
into a power outlet. For more information on batteries see "Modem 
Specific Information" on page 239.

2. Attach a phone line from a wall outlet to the back of your modem.

3. Place the modem so that its infrared port is facing Dana’s infrared port. 

Setting up Dana
You must perform a few steps to prepare your electronic notebook for 
communicating using an infrared modem.
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To prepare Dana:

1. Press the apps key repeatedly till you see ALL in the top right corner of 
the Applications Launcher.

2. Tap the Prefs icon.

3. Choose Connection from the category drop down list in the upper right-
hand corner.

4. Tap New. This will open the Edit Connections screen.

5. Enter “IR Modem” in the Name field.

6. Choose “Modem” from the Connect To drop down list.

7. Choose “Infrared” from the Via drop down list. Your screen should now 
look similar to the figure below.

8. Tap OK.

Setting up Aileron
You must perform a few steps to configure your email account information 
and setup Aileron to communicate using an infrared modem.

To prepare Aileron:

1. Press the apps key repeatedly till you see ALL in the top right corner of 
the Applications Launcher.

2. Tap the Aileron icon. 

3. Tap the Start Here button in the lower left-hand corner of Aileron’s main 
screen to start the Configuration Wizard. If there is no “Start Here” 
button then press the menu key. Under the Options menu tap Modem, 
then continue to step 5.
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4. Tap the Modem button.

5. Tap on the Modem drop down and choose the Other ISP option.

6. Tap the OK button.

7. Tap the Prefs button. If there is no Prefs button, continue to step 8. Tap 
OK.

8. Configure your email account information. You should now be back at 
the Configuration Wizard. If you are not at the Configuration Wizard 
screen, then press the menu key. Under the Options menu tap Profiles, 
then continue to step 10.

9. Tap the Profiles button.

NOTE: This button appears only after successfully configuring your 
preferences.

10. Enter your email address in the Email Addr field.

11. Enter your name in the Name field. This is the “friendly” name that will 
be shown in other peoples’ inboxes.

12. Tap on the Server line. If the automatically-generated server name is not 
correct, please enter the correct one here.

NOTE: This information may be found on your desktop email program, 
most likely under “Accounts.”

13. Enter your username in the Account field.

14. Tap -Unassigned- next to Password and enter your password. Tap OK to 
assign the password. Your screen should now look similar to the figure 
below.
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15. Tap OK to exit the profiles screen.

NOTE: To verify your account information, go to 
http://www.corsoft.com/check.asp and follow the instructions listed.

To configure Aileron to use the Infrared modem:

1. Press the menu key. Under the Options menu tap Network.

2. Press the menu key. Under the Service menu tap New.

3. Enter the name of your ISP (or simply enter “My ISP”) in the Service 
field.

4. Enter your user name in the User Name field.

5. Tap -Prompt- next to Password, enter your password and tap OK.

6. Choose IR Modem in the Connection drop down list.

7. Tap on Tap to enter phone and enter the dial-up phone number for your 
ISP. Check or otherwise complete the other options as appropriate for 
your phone line.

8. Tap OK.

9. Tap Done.You should now be back in Aileron.

10. Press the menu key. Under the Options menu tap Network.

11. Click on Service.

12. Choose the ISP you defined in step 3 above.Your screen now should 
look similar to the figure below.
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13. Tap Done.

To retrieve your mail:

1. Turn the modem on.

NOTE: On the Pegasus III modem, set the switch on the modem’s rear 
panel to IR. The modem automatically shuts off after a certain period of 
inactivity. If the green light goes off, press the ON button on the front 
panel to turn the modem back on.

2. Tap Mail.

3. Tap Connect.

4. When Aileron is finished sending and receiving emails, it will prompt 
you with a dialog. Tap Done.

NOTE: You should have successfully received any emails waiting for 
you and sent any that you have written. Please see the Aileron manual 
for instructions on how to use it most effectively.

Modem Specific Information
The following tables provide details about the Psion 56k Travel Modem 
and the 3JTech Pegasus III modem. 

Psion 56k Travel Modem
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Modem Type 56k V.90

Power 2 AA batteries or AC adapter (not included). Battery 
compartment on bottom of unit.

Controls Front Panel: Infrared port
Top Panel: On/Off switch, power indicator LED and 
data transmission/reception indicator LED.
Rear Panel: Telephone connection, AC adapter 
connection. GSM port available for European models.

LED Indicators Solid green light: Unit on, good batteries
Solid red light: Unit on, low battery indicator
Flashing red light: Battery too low to power modem

3JTech Pegasus III

Modem Type 56k V.90

Power 3 or 4 AAA disposable batteries (3 is optimal), 4 
rechargeable AAA batteries or AC adapter. Battery 
compartment on bottom of unit.

Controls Front Panel: Infrared port, On button, Status LED
Rear Panel: Telephone connection, AC adapter 
connection (labeled “DC”), power switch (set to IR to 
turn on).

LED Indicators Green: Power on
Red: Low battery indicator
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D
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event conflicts 101
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E
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untimed 92, 93

expansion card
beaming applications 152
copying an application 152
displaying application information 151

F
File Link 191
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FineType Converter 81
fonts, AlphaWord 81
fonts, choosing 141
full-screen pen stroke 161

G
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ShortCuts 48, 164
symbols 45
tips 41
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writing 39
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punctuation marks 42

H
hard reset 211
HotSync

conduits 188
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setting up 182
user profile 181
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via modem 185
via network 189

I
importing data 51
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K
key repeat 169
keyboard
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app shortcuts 168
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Mac OS system requirements 14
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Memo Pad, using 121
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choosing commands 25

modem
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preparing for HotSync 187, 235, 236
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N
network
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Network Log 206
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O
opening applications 22

P
password

assigning 61
changing or deleting 61

recovering 63
personalizing device 27
phone

connection to device 194
phone numbers

displaying different type 116
using phone lookup 136

power on keys 169
preferences

Date Book 98
Digitizer 21
formats 162
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keys 160
network 196
owner 27, 164
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R
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editing 127
finding 135
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login script 203
making 205
troubleshooting 206
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rotating the screen 172

S
screen contrast 21
screen, calibrating 21
screen, rotating 172
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security

assigning and editing passwords 61
making records private 138
masking and hiding records 60
setting options 60
using a password when logging onto your ISP 

or dial-up service 197
Service Connection Progress messages 206
ShortCuts
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soft reset 211
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alarm sound effects 144
volume 164

special needs keyboard 170
spell check 67
start time 104, 105
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system requirements 14

T
tapping, using stylus 20
TCP/IP software

about 193
connecting via 205

telephone numbers, selecting 116
thesaurus 70
time

setting 28
time bars 101, 104
tips

displaying 26
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changing display 111
changing due dates 110
changing priorities 110
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creating items 107
opening 107
private entries 110
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setting priorities 108
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type-select emulation 56

U
upgrade information 18

W
Week view 99
Windows system requirements 14
wireless text transfer 76


